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1 Introduction

This is the Graphic Hub Administrator Guide, which provides the information needed to configure
and operate the Graphic Hub.

This page contains the following topics:

Feedback and Suggestions
Graphic Hub Log Files
- Graphic Hub Component Logs
Graphic Hub REST Log Files
Graphic Hub ImEx Log Files

1.1 Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

1.2 Graphic Hub Log Files

A Graphic Hub overall report, which contains all Graphic Hub log files and additional system
information, can be generated in the Graphic Hub Terminal.

All services installed on the same machine will be included in the export.

If there is no Graphic Hub terminal running on the workstation where the Graphic Hub Deploy
Agent is running select and generate these log files:

- Graphic Hub Log files
Location: <current Graphic Hub data directory>/LogFiles
Purpose: Graphic Hub runtime and error information.
- System Event Log
Location: Start > Run... > eventvwr.exe > Event Viewer > Windows Logs
Name: System
Purpose: Information from the current windows system.
- To create: Right click on System and select Save all Events as...
- Application Event Log
Location: Start > Run... > eventvwr.exe > Event Viewer > Windows Logs
Name: Application
Purpose: Windows crash information of programs
- To create: Right click on Application and select Save all Events as...
- Vizrt Event Log
Graphic Hub Deploy Agent system log (only exists if Graphic Hub Deploy Agent is installed).
Location: Start > Run... > eventvwr.exe > Event Viewer > Applications and Services
Logs
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Name: Vizrt
Purpose: Deploy agent event log.
- To create: Right click on Vizrt and select Save all Events as...

1.2.1  Graphic Hub Component Logs
In general, all Graphic Hub Components log files containing important information:

Location: $PROGRAMDATA%\vizrt\COMPONENTNAME
Purpose: Configuration and logs of the Graphic Hub component

1.2.2 Graphic Hub REST Log Files

A Graphic Hub REST report, which contains all relevant log files and additional system information
according to Graphic Hub REST, can be generated in the Graphic Hub REST web interface.

If this is not possible select and generate these log files:

Location: %ProgramData%\vizrt\Viz GH Rest\logs
Purpose: Connection, error and event logs of the Graphic Hub REST.

1.2.3 Graphic Hub ImEx Log Files

A Graphic Hub ImEx Report, which contains all relevant log files and additional system information
according to Graphic Hub ImEx, can be generated in the Graphic Hub ImEx web interface.

If this is not possible select and generate these log files:

Location: %ProgramData%\vizrt\Viz GH ImEx Agent\logs
Purpose: Connection, error and event logs of the Graphic Hub ImEx Agent.
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2 Graphic Hub Administrator Guide

This is the Graphic Hub Administrator Guide, it covers the information needed to configure and
operate the Graphic Hub and its related components:

Graphic Hub Administrator Guide
Graphic Hub Deploy Agent
Graphic Hub ImEx Agent

Graphic Hub Manager

Graphic Hub REST

Graphic Hub Terminal

2.1 System Installation

The Graphic Hub can be installed in a Cluster, a Multi User (see Server Requirements) or a Single
installation mode (see Workstation Requirements). For more information on the different
installation options, see Which Graphic Hub Mode. The initial mode selection is performed during
installation. The Graphic Hub mode can also be changed and configured, once the Graphic Hub
Terminal has been started (see Graphic Hub Modes).

All Graphic Hub configurations are installed from one installation bundle, which includes the
Graphic Hub and the Graphic Hub Terminal.

This section contains information on the following topics:

Installation Prerequisites

- System Requirements
Installing Graphic Hub Applications
Licensing Graphic Hub

2.1.1 Installation Prerequisites

Before installing, upgrading or removing the Graphic Hub, make sure that you have gone through
this check-list:

Shut down the Graphic Hub, and stop the GH Terminal service.

Optional: When upgrading create a backup of the data directory by copying it. The cluster
solution is the only server setup with real-time data replication capabilities. For all other
system configurations, backup procedures must be executed manually.

& Note: Backup operations can only be done when the server is shut down.

When upgrading Graphic Hub, make sure that there are no open transactions on either of
the existing systems (see Check There are no Open Transactions).

& Note: The Open Transactions setting is only available for servers in a Cluster
environment.
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In a Cluster configuration, the Graphic Hub version number must be identical on the Main
and Replication machines. Mixed versions of Graphic Hub are not supported. Failure to heed
this can lead to serious system failure and data loss.
In a Cluster configuration, the Main and Replication machines must be started in mode Main
or Replication. Mixed Graphic Hub modes in a cluster are not supported. Failure to heed this
can lead to serious system failure and data loss.
Make sure that the data directories of the main and replication servers are exclusive, so that
no other Graphic Hub or process uses these directories.
Do not use Windows Remote Desktop to install and/or work with Graphic Hub on versions
below 3.0.0. Instead, use another remote tool, for example VNC.
Make sure that no other applications on the server workstations can cause performance
problems. Some examples of situations when databases should not be installed are:

The general CPU usage is above normal.

Viz Artist is used on the same machine.

Other databases run on the same machine.

The network traffic is extensive.

& Note: Running a virus scanner on the Graphic Hub machine can decrease the performance
of the database.

The performance of the database depends upon the performance of the physical machine the
database runs on. As system performance increases, so does the database performance. This is
why it is highly recommended to use a server with high performance.

Software Prerequisites
Prior to installation the following prerequisites are required for all Graphic Hub applications:

Microsoft .NET Framework 4.8.0 (or newer): https://www.microsoft.com/net/download/
framework

Visual Studio 2010 x64 redistributable (installed by the Graphic Hub bundle installer)
Visual Studio 2015-2022 x64 redistributable (installed by the Graphic Hub bundle installer)

Check Open Transactions

From Graphic Hub 3.0, the status of open transactions is shown in the GH Terminal main screen:
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© Warning: Do not proceed with an upgrade if there are any open transactions!

If required, the Graphic Hub Console can also be opened to check for open transactions. In the
Graphic Hub Terminal, click Report > Graphic Hub Console.

For all previous Graphic Hub versions, use the following procedure:

1. Open Graphic Hub Manager on both the machines (Main and Replication).
2. From the main menu, select Tools > Monitor Servers.
3. Check that Open Transactions are at zero.

2.1.2 System Requirements

This section details the requirements for multiple clients to access a Graphic Hub (installations
with more than one server), which includes Multi User, Main Server and Replication Server
configurations, as described in the Graphic Hub Modes section.

A Note: Support for any specific operating system or service pack version is only provided by
Vizrt as long as it is officially supported by Microsoft. Support end dates are announced in
the release notes for new versions of all Graphic Hub components. Other Vizrt products
may be supported on other platforms and the documentation and release notes for the
product in question should be consulted separately.

This page contains the following topics:

Graphic Hub Requirements

Graphic Hub as Viz Pilot Backend System
Small Installations
Medium Installations
Large Installations

Deploy Agent Requirements

Graphic Hub REST Requirements

ImEx Agent Requirements

- Workstation Requirements

Hardware Requirements
Deploy Agent Requirements
Graphic Hub REST Requirements
Graphic Hub ImEx Agent Requirements

Service Dependencies

Graphic Hub Requirements

These are the minimum requirements for the Graphic Hub:
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Component Minimum Requirement

System - Microsoft Windows Server™ 2016 (64-bit)
Microsoft Windows Server™ 2019 (64-bit)
Microsoft Windows Server™ 2022 (64-bit)
- The above operating systems as virtual machine on ESXi 6.0
Update 2 (build 3620759) or higher.

& On virtualized environments snapshot tools (for
example, VEEAM) or migration (VMotion) of VMs are
not supported. Main/Replication setups make only
sense when separated on different ESXI hosts.

No other applications may be installed on the server machine.
- Anti-virus software without endpoint protection and excluding
the following Graphic Hub processes:
VizGH.exe
VizGHNamingservice.exe
VizGHTerminalService.exe

© IMPORTANT! All data directories must be excluded from
anti-virus scan operations and monitoring.

Browser Browser requirements (minimum and recommended versions):

- Google Chrome (recommended): 45+ (tested with 91)
Microsoft Edge (96+)

CPU Eight cores with 2.4 GHz base frequency

RAM 8 GB DDR4-1866
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Minimum Requirement

Hard disk performance has a noticeable impact on the overall
performance of the Graphic Hub. Therefore, the recommended
hard disk setup is a RAID 10 configuration over all disks, with
indexing service disabled for the directory containing the Graphic
Hub data:

Expand priority: Medium
Rebuild priority: High
- Cache Usage: 50% Read, 50% Write

The amount of disk space depends on the amount of data to be
stored, but should be at least 400 GB for data.

In addition, 40 GB is required as a separate Operating System
partition.

& Note: It is not possible to use mapped network drives for
the Graphic Hub data directory for performance and data
integrity reasons.

© Warning: Running the Graphic Hub on a system without
enough available hard disk space can cause warnings,
unexpected behavior, and data loss. Make sure to stay
well within the limits as described in Warning and Error
Thresholds.

A redundant (teamed) setup with two Gigabit network adapters is
recommended.

A redundant power supply is highly recommended.

Graphic Hub as Viz Pilot Backend System

When the Graphic Hub is used as the data back end for Viz Pilot, the following requirements need

to be considered in addition to the Graphic Hub Requirements. In general, the CPU, RAM and hard

disk requirements are highly dependent on the amount of graphics, Pilot data (VCP data elements,
templates, variants and concepts) the database contains, and how many parallel clients (Viz Artist/
Viz Engine, VCP/ActiveX, Viz Story, Viz Pilot Edge) are active.

For a the list of compatible versions, see Viz Pilot Database Management.

Small Installations

Small setups run on a single machine with all the necessary components installed: Graphic Hub
5/4 Free, Graphic Hub REST, Data Server and Media Sequencer. Such an installation can serve up to
five Viz Artist/Engine clients based on IP, and up to three VCP/ActiveX clients. Depending on the
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hardware specifications, performance is limited by the amount of VCP data elements, templates,
variants and concepts.

Component Minimum Requirement

CPU Eight cores with 3 GHz base frequency.

RAM 16 GB DDR4-1866

HDD The amount of disk space depends on the amount of data to
be stored.

Graphic Hub (5/4 Free)
Graphic Hub REST
Data Server

Media Sequencer

Viz Pilot Viz Pilot ActiveX Viz Artist/Engine

Medium Installations

Medium Installations run Graphic Hub in Multiuser mode and Graphic Hub REST on one physical
server.
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Component Minimum Requirement

CPU 12 cores with 3 GHz base frequency.

RAM 16 GB DDR4-1866

HDD The amount of disk space depends on the amount of data to
be stored.

Graphic Hub [(Multiuser)
Graphic Hub REST

Data Server

Wiz Artist/Engine
Media Sequencer

Viz Pilot Viz Pilot ActiveX
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Large Installations

For customers with larger installations, it is required to run Graphic Hub and Graphic Hub REST on
separate and more powerful hardware. If performance issues occur, the Graphics and VCP content
should also be separated. For an optional failsafe system, at least two instances of Graphic Hub
REST and an HTTP Proxy are required.

© IMPORTANT! The hardware configuration for a large installation needs to be defined in
collaboration with Vizrt based on the individual customer’s requirements.

Minimum suggested configuration:

Component Minimum Requirement

CPU 16 cores with 3 GHz base frequency

RAM 32 GB DDR4-1866

HDD The amount of disk space depends on the amount of data to
be stored.

This is an illustration of an example installation scenario, of a Graphic Hub cluster with redundant

Graphic HUB REST service. The HTTP proxies are optional, and only needed for complete
redundancy of the Graphic Hub REST service.
Graphic Hub REST

Cuata Server
Optional: HTTP prosy and 2nd REST/Data Server

Graphic Hub Cluster
{Bain and Replication)

I
>

Viz Artist/Engine

Wiz Pilot Wiz Pilot ActiveX
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& Note: This illustration covers redundancy of Graphic Hub and Graphic Hub REST only. It
does not cover redundancy for Viz Pilot or Media Sequencer.

Deploy Agent Requirements

This section details the requirements for the Deploy Agent:

Component Minimum Requirement

System - Microsoft Windows Server™ 2016 (64-bit)

Microsoft Windows Server™ 2019 (64-bit)
Microsoft Windows Server™ 2022 (64-bit)

- The above operating systems as virtual machine on ESXi 6.0
Update 2 (build 3620759) or higher.

- Anti-virus software without endpoint protection and
excluding the Deploy Agent process:
VizGHDeployAgentService.exe.

CPU Four cores with 2.4 GHz base frequency.

RAM 4 GB DDR4-1866

HDD 80 GB of free disk space for data.
In addition, 40 GB is required as a separate Operating System
partition.

A Note: Support for any specific operating system or service pack version will only be
provided by Vizrt as long as it is officially supported by Microsoft. Support end dates will
be announced in the release notes for new versions of Graphic Hub. Other Vizrt products
may be supported on other platforms, however, and the documentation and release notes
for the product in question should be consulted separately.

Graphic Hub REST Requirements
This section details the requirements for the Graphic Hub REST:
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Component Minimum Requirement

System - Microsoft Windows Server™ 2016 (64-bit)

Microsoft Windows Server™ 2019 (64-bit)
Microsoft Windows Server™ 2022 (64-bit)

- The above operating systems as virtual machine on ESXi 6.0
Update 2 (build 3620759) or higher.

- Anti-virus software without endpoint protection and
excluding the Graphic Hub REST process:
VizGHRESTService.exe.

No other applications, except the Graphic Hub in 5/4 Free or
Localhost configurations, may be installed on the server
machine.

Browser Browser requirements (minimum and recommended versions):

- Google Chrome (recommended): 45+ (tested with 91)
Microsoft Edge (96+)

CPU Eight cores with 2.4 GHz base frequency.
RAM 4 GB DDR4-1866
HDD 400 GB of free disk space for data.

In addition, 40 GB is required as a separate Operating System
partition.

A Note: If you also want to run this machine as your general web server, Vizrt cannot make
specific recommendations regarding hardware requirements.

ImEx Agent Requirements

This section details the requirements for the ImEx Agent:

Component Minimum Requirement

System - Microsoft Windows Server™ 2016 (64-bit)

Microsoft Windows Server™ 2019 (64-bit)
Microsoft Windows Server™ 2022 (64-bit)

- The above operating systems as virtual machine on ESXi 6.0
Update 2 (build 3620759) or higher.

- Anti-virus software without endpoint protection and
excluding the ImEx Agent process:
VizGHImExAgentService.exe.
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Component Minimum Requirement

CPU Four cores with 2.4 GHz base frequency.

RAM 4 GB DDR4-1866

HDD 5 GB of free disk space for temporary data on the operating

system partition.

Workstation Requirements

This section details the requirements for installations on laptops and desktop workstations
running the Graphic Hub in Localhost or 5/4 Free mode or for demonstration purposes.

Hardware Requirements

The following hardware is required:

Component Minimum Requirement
System - Microsoft Windows® 10 loT Enterprise 2019 LTSC (64-bit)
Browser Browser requirements (minimum and recommended versions):

- Google Chrome (recommended): 45+ (tested with 91)
Microsoft Edge (96+)

CPU Two cores with 2.4 GHz base frequency.
RAM 4 GB DDR4-1866
HDD The amount of disk space depends on the amount of data to be

stored, but should be at least 50 GB for data.

In addition, 40 GB is required as a separate Operating System
partition.

Deploy Agent Requirements

The following hardware is required for the Deploy Agent:

Component Minimum Requirement
System - Microsoft Windows® 10 IoT Enterprise 2019 LTSC (64-bit)
CPU Two cores with 2.4 GHz base frequency.
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Component Minimum Requirement
RAM 4 GB DDR4-1866
HDD The amount of disk space depends on the amount of data to be

stored, but should be at least 5 GB for data.

In addition, 40 GB is required as a separate Operating System
partition.

Graphic Hub REST Requirements
The following are required for the Graphic Hub REST:

Component Minimum Requirement
System - Microsoft Windows® 10 loT Enterprise 2019 LTSC (64-bit)
Browser Browser requirements (minimum and recommended versions):

- Google Chrome (recommended): 45+ (tested with 91)
Microsoft Edge (96+)

CPU Two cores with 2.4 GHz base frequency.

RAM 4 GB DDR4-1866

HDD 200 GB of free disk space for data.
In addition, 40 GB is required as a separate Operating System
partition.

Graphic Hub ImEx Agent Requirements
The following are required for the Graphic Hub ImEx Agent:

Component Minimum Requirement
System - Microsoft Windows® 10 loT Enterprise 2019 LTSC (64-bit)
Browser Browser requirements (minimum and recommended versions):

- Google Chrome (recommended): 45+ (tested with 91)
Microsoft Edge (96+)

CPU Two cores with 2.4 GHz base frequency
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Component Minimum Requirement
RAM 4 GB DDR4-1866
HDD 5 GB of free disk space for temporary data on the operating

system partition.

Service Dependencies

The different components of the Graphic Hub depend on certain system services. If the services
are not running during installation, a notification appears with information about the required
services. The services are enabled by default on pre-configured systems, but may have been
disabled to comply with your organizations IT policy.

The following table lists the service dependencies for each Graphic Hub component:

Graphic Hub Component Service Name Service Display Name
Graphic Hub Terminal LanmanServer Server

HTTP HTTP

RpcSS Remote Procedure Call (RPC)
Graphic Hub Deploy Agent LanmanServer Server

RpcSS Remote Procedure Call (RPC)
Graphic Hub REST LanmanServer Server

RpcSS Remote Procedure Call (RPC)
Graphic Hub ImEx Agent LanmanServer Server

HTTP HTTP

RpcSS Remote Procedure Call (RPC)

2.1.3 Installing Graphic Hub Applications

This page contains the following topics and procedures:

- To Install a Graphic Hub
Graphic Hub REST Installation
GH Deploy Agent Installation
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Graphic Hub Manager Installation
Graphic Hub ImEx Agent Installation
Unattended Installation of Graphic Hub Applications

This section details the installation of the Graphic Hub, including a Cluster configuration, which
installs a Main and a Replication server.

Please be aware that:

Multiuser, Main and Replication modes require a Graphic Hub Core license.

- The Image Library Extension functionality requires a Graphic Hub Image Library Extension

license.

- To setup a cluster configuration capable of handling failover situations, a combination of

Main and Replication servers must be configured.

To Install a Graphic Hub

To install the Graphic Hub with the MSI installer use in the following installation order:

1.

uTh WN

Microsoft .NET Framework 4.5.2 (or newer): https://www.microsoft.com/net/download/
framework

vcredist_x64.exe Visual C++ 2015 Redistributable (x64)

openslp_2.0.0_0_x64.msi Service location protocol daemon

VizGraphicHub_64bit-XX.msi

optional: HASPUserSetup.exe Dongle driver (required for GH Multiuser, Main and Replication
modes)

To install the Graphic Hub with the bundle installer (installs 2-5 listed above) use in the following
installation order:

1.

2.

Microsoft .NET Framework 4.5.2 (or newer): https://www.microsoft.com/net/download/
framework
VizGraphicHubBundle-x64-XX.exe

- The installation wizard reports the version and build number of the bundle about to
be installed. If an existing Graphic Hub installation is located, the installer reports the
version and build number of the existing installation as well.

& Note: During upgrade installations, the currently installed mode and data
directory are suggested automatically by the installer.

- Select the mode and data directory for the Graphic Hub installation.
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If required, click Additional Settings to install the Graphic Hub to a custom location or
with a custom HTTP port for the Graphic Hub Terminal.

Additional Settings

Install Folder
CA\Program Fileshwizrt\VizGHY,

Termimal HTTP Port

For first time installations, the OpenSLP, Sentinel Runtime and CodeMeter

Runtime checkboxes are automatically checked. In the event that any of these
packages have been installed on the system previously, it is not possible to select
them for installation.

The installation wizard also automatically installs the Microsoft C++ Redistributable
Package.

After the installation has completed successfully, the Graphic Hub Terminal opens in
the default web browser. The contents of the Graphic Hub Terminal window depends
on the selected Graphic Hub configuration.

< Graphic Hub Terminal - GHServer

Optional: Silent installation
The -s or -silent option means that there is no user interaction necessary.
The Bundle window is still displayed.

Cluster Server Installation

To use a Graphic Hub in a Cluster configuration (Main and Replication servers), two separate
servers must be available and a Graphic Hub dongle must be applied to each machine.
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The Main server is installed and configured on one machine. The Replication server is installed and
configured on the other.

© IMPORTANT! When the Graphic Hub is upgraded from a different mode the same content

must be used (data directory). As such, the underlying data directory must be copied first
to both machines (see also Graphic Hub Mode Configurations).

To Install And Configure A Graphic Hub Cluster

1.

2.

3.

Install the Graphic Hub on both servers as described above in To Install a Graphic Hub.
Select Main Server as mode for the server which is intended to run as Main, and Replication
Server for the other one.

When the installation finishes, the Graphic Hub Terminal automatically opens on both
servers. Select the servers that will act as GH Main Server and GH Replication Server from the
respective drop-down lists, and click Create.

Main server F.Eph'l:atibﬁ senrver

GH-REPLICATION

A Note: If the Graphic Hub has been installed previously, the new installation defaults
to the same data directory, unless a new one is selected during installation or
configuration.

Enter the configuration for the Main Server:
Configuration: Main server (gh-main:19399)

Data directory™®

Mamang Service Port

Metwark Adapter

Ak 4

Step 1/2

Graphic Hub: Enter the Server name and set the Data directory.
Connections settings: Select the Port, Network Adapter and Server Port.
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4. Click Next and enter the configuration for the replication server, then click Finish.

If required, click Configuration to change any settings.
If required, click Automatically start of partner server to automatically start the
Replication server.

5. Click Start Server for both the Main and Replication servers.

Graphic Hub Cluster Upgrade

© IMPORTANT! When upgrading a Graphic Hub cluster, make sure that all connections to the
Graphic Hub are closed by checking active sessions and that there are no open
transactions.

& Note: Graphic Hub clients and servers are designed to be inter-operable between versions,
but may lack new features. This means old clients work on older and newer Graphic Hub
versions and there is usually no need to upgrade clients when upgrading the Graphic Hub,
except when certain features are required or critical bugs have been fixed.

Shut down Deploy Agent or Agents.

Shut down the Graphic Hub Cluster.

Remove Deploy Agent or Agents.

Install new version of the Deploy Agent or Agents (see GH Deploy Agent Installation).
Install new version of Graphic Hub on the Main and Replication Server (see Graphic Hub
Installations).

Optional: Remove all occurrences of the Graphic Hub Manager. Install new version of the
Graphic Hub Manager (see Graphic Hub Manager Installation).

Start the Graphic Hub Cluster.

Start any Deploy Agents.

uTh WN —

o

®© N
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Graphic Hub REST Installation
This section details the installation of the Graphic Hub REST.

The Graphic Hub REST is a web-service for Graphic Hub. It is an interface to retrieve and send data
to and from Graphic Hub via HTTP requests.

Important Before Installation

- Graphic Hub REST requires Graphic Hub 2.3.1 or higher.

- Graphic Hub REST requires Graphic Hub 3.0.0 (recommended 3.0.2) or higher for Pilot data
access (see Viz Pilot Database Management for details).
For performance reasons, do not install Graphic Hub REST on a Main server in a Graphic Hub
cluster environment.

For best performance and compatibility, use Google Chrome version 28 or higher to configure
Graphic Hub REST. The Graphic Hub REST Web-Ul also works with:

Recommended Browser Version Requirement (minimum and

recommended)
Google Chrome™ (Recommended) 28, 45+
Mozilla Firefox™ 25,41+
Microsoft Edge 96+

Also Tested on
Microsoft Internet Explorer™ 9, 10+
Apple Safari™ 5,6

Opera™ 15, 36+

© IMPORTANT! Any other web browser or versions older than the ones listed above are not
officially supported.

To Install the Graphic Hub REST
Follow this installation order to install Graphic Hub REST:

1. Microsoft .NET Framework 4.5.2 (or newer): https://www.microsoft.com/net/download/
framework

2. vcredist_x64.exe Visual C++ 2015 Redistributable (x64)

3. openslp_2.0.0_0_x64.msi Service location protocol daemon

4. VizGHREST_64bit. XX.msi
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- Optional: Check the details for:
- Graphic Hub Naming Service
- Graphic Hub Server Name
- Graphic Hub Port
- Graphic Hub REST HTTP Port
- Optional: Silent installation
- The -s or -silent option means that there is no user interaction necessary.

The Bundle window is still displayed.
- Optional: Enable the SSL configuration:
- Check the Enable SSL Encryption checkbox.
Enter the location of the Certificate and Private Key files.
Enter the password.

© IMPORTANT! The certificate files must be configured during the installation of
GH REST.

- After the installation has completed successfully, the Graphic Hub REST Web-Ul opens
in the default web browser.

& Note: Make sure that the browser type and version is supported by Graphic
Hub REST (see Important Before Installation).

GH Deploy Agent Installation

This section details the installation of the Graphic Hub Deploy Agent. The Deploy Agent is required
to run scheduled Deploy Tasks. This is useful to replicate data for safekeeping or distribution on a
regular basis.

To install the Graphic Hub Deploy Agent use in the following installation order:

1. Microsoft .NET Framework 4.5.2 (or newer): https://www.microsoft.com/net/download/

framework
2. vcredist_x64.exe Visual C++ 2015 Redistributable (x64)
3. VizGHDeployAgent_64bit. XX.msi

This creates two Deploy Agent icons in the Start menu, under Programs > Vizrt > Viz Graphic Hub
> Deploy Agent.

The Deploy Agent is now configurable with the Graphic Hub Manager.

Graphic Hub Manager Installation

This section details the installation of the Graphic Hub Manager.

To Install the Graphic Hub Manager
To install the Graphic Hub Manager use in the following installation order:

1. Microsoft .NET Framework 4.5.2 (or newer): https://www.microsoft.com/net/download/
framework
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2. vcredist_x64.exe Visual C++ 2015 Redistributable (x64)
3. VizGHManager_64bit. XX.msi

Graphic Hub ImEx Agent Installation
This section details the installation of the Graphic Hub ImEx Agent.

The Graphic Hub ImEx Agent is a media asset (image) import service from HTTP sources for the
Graphic Hub.

Important Before Installation

Before installing the Graphic Hub ImEx Agent, make sure to familiarize yourself with the Service
Dependencies. Also, observe the following requirements:

Dependencies Required Components
Graphic Hub 3.0.1 or newer
GH REST 2.0.1 or newer

Recommended Browser Version Requirement (minimum and

recommended)
Google Chrome™ (Recommended) 28, 45+
Mozilla Firefox™ 25,41+
Microsoft Edge 96+

Also Tested on
Microsoft Internet Explorer™ 9, 10+
Apple Safari™ 5,6

Opera™ 15, 36+

© IMPORTANT! Any other web browser or versions older than the ones listed above are not
supported.

To Install the Graphic Hub ImEx Agent
To install the Graphic Hub ImEx Agent use in the following installation order:

1. Microsoft .NET Framework 4.5.2 (or newer): https://www.microsoft.com/net/download/
framework
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2. vcredist_x64.exe Visual C++ 2015 Redistributable (x64)
3. VizGHImexAgent_64bit. XX.msi

- Optional: Configure IMEX HTTP port. The default port number is 19390 . The port

number can also be changed in the configuration of the Graphic Hub ImEx Agent after
installation.

- When the installation completes, the web-based user interface opens in the default
browser, for initial Graphic Hub ImEx Agent configuration.

Recommended Browser Version Requirement (minimum and

recommended)
Google Chrome™ (Recommended) 28, 45+
Mozilla Firefox™ 25,41+
Microsoft Edge 96+
Also Tested on
Microsoft Internet 9, 10+
Explorer™
Apple Safari™ 5,6
Opera™ 15, 36+

Unattended Installation of Graphic Hub Applications

Installation Parameters

Parameter name Default Value Available values

VizGraphicHub MSI

INSTALLDIR_GH %\Program Files%
\Vizrt\VizGH\
DATADIR_DB C:\VizGHData\

TERMINAL_HTTP_PORT 19399

GH_MODE 2 1,2,3,4,5
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PLATFORMTYPE

VizGHREST MSI

INSTALLDIR_REST

REST_NAMING_SERVICE
REST_SERVER_NAME
REST_SERVER_PORT
REST_HTTP_PORT
SSL_ACTIVE
SSL_CERTIFICATE_FILE
SSL_PKEY_FILE
SSL_PKEY_PASSWORD
VizGHImexAgent MSI

INSTALLDIR_AGENT

IMEX_HTTP_PORT

VizGHManager MSI

INSTALLDIR_MANAGER

DO_LAUNCHAPPONEXIT
VizGHDeployAgent

INSTALLDIR_AGENT

S54free

%\Program Files%
\Vizrt\VizGH\REST\

LOCALHOST
VizDbServer
19396
19398

No

null

null

null

%\Program Files%
\Vizrt\VizGH\ImexAgent\

19390

%\Program Files%
\Vizrt\VizGH\Manager\

0

%\Program Files%
\Vizrt\VizGH\DeployAgent\
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"localhost”, "54free

, "multiuser”,

"mainserver", "replicationserver"”

yes
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Example

Description Command

Install Graphic Hub silently with no Ul using the  msiexec /i VizGraphicHub.ms1
msi in Multiusers mode

Install Graphic Hub to path C:\Vizrt\GH
GH Data Directory configured to D:

PLATFORMTYPE="multiuser"
INSTALLDIR_GH="C:\Vizrt\GH"

\Vizrt\GHDataDir DATADIR_DB="D:\Vizrt\GHDataDir"
GH terminal service to run on port 19300 TERMINAL_HTTP_PORT="19300" /1lv c:
Installation log in verbose mode named \Temp\instgh_mode.log /gn

instgh_mode.log and deployed to path C:\Temp

Install Graphic Hub silently using the Graphic VizGraphicHubBundle-x64.exe --
Hub bundle installer in localhost mode
Install Graphic Hub to path C:\Temp

silent --
GraphicHub="PLATFORMTYPE=1ocalhost
INSTALLDIR_GH="C:\temp'"

(@ Information: The Graphic Hub installer parameters GH_MODE and PLATFORMTYPE cannot
be combined in one command, only one of them can be used at a time.
See Also
SSL in REST

2.1.4 Licensing Graphic Hub
There are five possible modes to run Graphic Hub (see Graphic Hub Modes):

Modes working without a license
- Viz Graphic Hub Localhost
- Viz Graphic Hub 5/4 Free
Modes that require a Dongle/License
- Viz Graphic Hub Multiuser
- Viz Graphic Hub Main Server
- Viz Graphic Hub Replication Server

This section describes how to license Graphic Hub using a Graphic Hub Sentinel license dongle or
WIBU License, which is required for Graphic Hubs running in Multiuser, Main or Replication mode.

For more information on how to apply licenses, check the Vizrt Licensing Guide in the Vizrt
documentation center or for details on how to setup the licensing system to be used by Graphic
Hub.

This page contains the following topics and procedures:

Using WIBU Licensing of Graphic Hub
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Using WIBU Licensing of Graphic Hub

Graphic Hubs can be licensed with a special WIBU License. The required WIBU Runtime Software
comes with the Graphic Hub Bundle installer and is mandatory for the modes Multiuser, Main and
Replication.

If a WIBU License is found and bound it sticks to this license container and can only be changed by
a restart of the Graphic Hub.

License expiration messages are logged to the Graphic Hub Journal as usual (alerts, expiration
warning 30 days prior to expiration and if license is expired or invalid). The WIBU license
information (license id, license server, container id) is logged to the Graphic Hub log file upon
status changes.

Currently supported WIBU licenses:

- Graphic Hub Core license with ID 1300000 (license format v2, supported since version 3.1.0)
and 130000 (license format v3, supported since version 3.8.0).

- Graphic Hub Image Library Extension license with ID 130100 (license format v3, supported
since 3.8.0) to enable the Image Library write capabilities.

Basic steps to enable WIBU licensing with Graphic Hub:

1. Setup a WIBU license container as described in the Vizrt Licensing Guide in the Vizrt
documentation center.

2. Install the Graphic Hub with the CodeMeter Runtime. See System Installation for details.

3. Configure the WIBU settings and the appropriate location of the license container in GH
Terminal Configuration > ADVANCED SETTINGS > License Settings. See Graphic Hub Mode
Configuration for details.

To verify if the license is applied correctly, please check either the:
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- GH Terminal Graphic Hub license information (reached via About > Graphic Hub License in
GH Terminal):

< Graphic Hub Terminal - GHDemo

Multiuser (GHDEMO)

u

License string

= Graphic Hub Terminal - GHDemo

ku t Options About

Status:  Server and naming service are up and running.

Server: G
PHIC HUI complete file
e Nov 7.11.20 14: 51.264009: Viz Graphic Hub version 3.8.3.71142
M B o 1 - (Made in Austria)
e
: License information:
B s
Multiuser (888 concurrenmt
License information:
censed.
11-87 13:49:5@ GMT
1.311000: License
1168808
server = QAT-THRE zrt.internal
container

100 GMT]
100 GMT]

I T
Data location:
e
zGHData)
B
open files in total:
e

c Refresn
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GH Manager license information (reached via Info > License info... in GH Manager):

Pt License info for server 'VizDbServer@GHDEMO' — Od >
Server: VizDbServer @GHDEMO (Admin)

License details:

The license info shown below is that of & non server dongle!

Serial Mumber: 11 00 00 00 00 00 00 00

Key Mumber: 0

Product expiry date: 30.11,2017 (expires in 24 days!)

Feature expiry date: 30.11. 2017 (expires in 24 days!)

Features:

User Management: Expiry date: 30,11, 2017 (expires in 24 days!)

License string: |License cannot be set, because the connected dongle is not a server dongle!

[#5]
m

Close

GH Manager monitor (reached via Tools > Monitor servers... in GH Manager):
#t Monitor servers - m] x

@ VizDbServer @GHDEMO

Overview Digk: Memory
@ Disk Total: 58,00 GB Total: 8,00GB
@ Memory Used: 37,59 GB Free: 6,24 GB
& License Free: 20,41GB Used: 1,75GB
@ Health Free %: 35,19 % Used %: 21,94 %

Limit: 1 000,00 MEB

License & Health Activity
Expires: Deadlocks: 1] Calls: 221
In 22 days. Active sessions: [ Callsfsec: 0,10
File opens: 1] Peak: 0,20
Files: 1] O callsfsec: 0,59
z Files in memary: 1] @ peak: 0,60

& Note: License changes (for example, setting a new license key) are not supported for WIBU
Licenses. Setting a new license string does not work in GH Terminal and GH Manager, since
these changes must be performed in the CodeMeter Runtime.

2.2 Overview

The Graphic Hub is a database solution where all Viz Artist elements are stored. Files can be
Scenes, Geometries, Images, Materials, Fonts, and so on.

To start Viz Artist successfully, a Graphic Hub must be running. The Graphic Hub can either be a
local instance, where only one User can log in, or it can be a Multi-User database as described in
Graphic Hub Modes.

This section contains the following topics:

Graphic Hub Applications
Graphic Hub Modes
- Selecting a Graphic Hub Mode
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General Database Information
Graphic Hub Naming Service

2.2.1 Graphic Hub Applications

The Graphic Hub solution consists of these applications:

Graphic Hub

Graphic Hub Terminal
Graphic Hub Manager
Graphic Hub REST

Graphic Hub Deploy Agent
Graphic Hub ImEx Agent
Graphic Hub Naming Service

Graphic Hub

The physical back end server where the database content is stored (see General Database
Information).

Graphic Hub makes the database available to clients in a network. To log in and work with Viz
Artist, a User must connect to a running Graphic Hub, on a machine in the network. In normal
circumstances a Graphic Hub is started through the Graphic Hub Terminal, and shut down, logged
in to or logged out of, from the Graphic Hub Manager.

Various parameters can be defined in the Graphic Hub Terminal before a Graphic Hub is started,
for example the name and the data directory to where the database should have its root folder.

The integrated multi-user database serves as the central point for storing all assets of a standalone
machine or for all machines. This asset management database provides efficient file-handling
while maintaining data consistency.

Consistent data storage: Objects are always aware of their references and stay consistent
where ever you move them. Accidental deletions of objects are prevented and scenes remain
usable.

Reference model: Guarantees that changes of a special object/type affects all scenes using
it, such as a corporate logo or font-style.

Flexible data organization: Organizing scenes and all relevant objects together in projects,
simplifies the task of handling complex designs.

Data locking: Exclusive access to scenes or objects is assured by applying a lock.

- Audio: Supports audio streaming.

- Administrative tool Graphic Hub Manager: Serves to migrate archives and data pools from
version 2.x. Graphic Hub Manager also serves as a tool for adding users, keywords,
permissions, statistical information regarding disk usage, connected users and server traffic
as well as assisting the user in finding duplicates.

User management: Enables you to protect crucial assets and track changes.
Search functionality: All object properties can serve as search criteria and new search
keywords can be included.
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Messaging/notification: Broadcast information to all connected clients via a customized
notification system and/or online collaboration between single users.

Graphic Hub Terminal

The Graphic Hub Terminal is the user interface used to configure, start, stop and restart both
Graphic Hub and the Graphic Hub Naming Service. See Graphic Hub Terminal.

A Graphic Hub Terminal is installed along with every Graphic Hub and provides the following
functionality:

- Starting, stopping and monitoring Graphic Hub and the Graphic Hub Naming Service
processes.

- Configuring Graphic Hub.

- Status Display and monitoring.
Execution of scheduled tasks: shutdown (with automated backup), deletion of Journal
Entries, deletion of expired items, cleanup of Viz Pilot data elements, cleanup of Viz Pilot
changelog.
Backup and Restore.
Emailing.
Report generation.

Graphic Hub Manager

The Graphic Hub Manager is used to administer one or more Graphic Hubs. For example, the
server files and access levels for users and groups can be managed from this application. See
Graphic Hub Manager.

Graphic Hub Manager serves to:

Migrate Viz Pilot data from Oracle to Graphic Hub.
Migrate archives and data pools from version 2.x.

- As a tool for adding users, keywords, permissions, statistical information regarding disk
usage, connected users and server traffic as well as assisting the user in finding duplicate.

When you are running in a Main/Replication Cluster, you can check Server differences and Copy via
DDC from one server to another.

Graphic Hub REST

The Graphic Hub REST is a web-service for a Graphic Hub. It is an interface to retrieve and send
data to and from a Graphic Hub through HTTP requests. See Graphic Hub REST.

Supports browsing, administration, simple manipulation of datasets, monitoring, deploy agents,
and much more. It provides the access to all data on a Graphic Hub. A client is able to retrieve any
kind of metadata from Scenes, Images, etc., like Owner, Creation Date, etc. Also, all metadata, like
Users, Types, Keywords, can be retrieved.

Graphic Hub REST is also an open HTTP API to Graphic Hub. Any skilled web developer and
designer can build an application based upon the Graphic Hub Interface Agent. For example, if a
scene from the Super Bowl contains an image of the quarterback, this image can be retrieved by an
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external application, like a blog, by a search on the Graphic Hub Interface Agent. The blogger is
also able to insert this in an article and publish to the web.

Graphic Hub Deploy Agent

Upgrades the Graphic Hub solution with a powerful service to copy directories/projects/files with
all necessary data (referenced directories/projects/files) from one server to another. See Graphic
Hub Deploy Agent.

Graphic Hub Deploy Agent upgrades your Graphic Hub solution with a powerful Service to copy
directories/projects/files with all necessary data (referenced files, directories/projects) from one
server to another with different options of deployment. It is possible to have more than one agent
running in your network environment. To copy between your servers, you can create tasks in
Graphic Hub Manager. In these tasks you define the source and destination servers and properties
of the deploy task.

It is possible to deploy to multiple destination servers. Every task can have different schedule
modes. These modes are Once, Recurring, Recurring forever and Real-Time. So it is possible to
distribute your Graphic Hub content according to schedule to all your servers automatically day by
day.

Graphic Hub ImEx Agent

The Graphic Hub ImEx Agent (Import / Export agent) is a service that imports image media assets
from file-system folders or HTTP sources to Graphic Hub. See Graphic Hub ImEx Agent.

Graphic Hub ImEx Agent upgrades your Graphic Hub solution with a powerful Service to stage
(import) external media assets (images) available through HTTP through the Media Sequencer
(MSE) to Graphic Hub through Graphic Hub REST. It is possible to have more than one agent
running in your network environment that can utilize multiple Graphic Hub RESTs.

Dedicated destination directories can be configured. The import can be parallel on multiple
Graphic Hub RESTs bound to the same Graphic Hub.

Graphic Hub Naming Service

The Graphic Hub Naming Service monitors all applied servers in the network. See Graphic Hub
Naming Service.

See Also

Graphic Hub Modes
General Database Information
Graphic Hub Naming Service

2.2.2 Graphic Hub Modes

Graphic Hub Terminal can operate in these modes:

Localhost
5/4 Free
Multiuser
Main Server
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Replication Server

Localhost

Localhost is a single connection to a Graphic Hub (no dongle required). See Localhost, 5/4 Free,
and Multiuser Configuration.

5/4 Free

The 5/4 Free configuration provides five concurrent TCP/IP connections to a Graphic Hub (no
dongle required, five TCP/IP connections excluding GH Terminal, GH Manager, GH Deploy Agent
connections). See Localhost, 5/4 Free, and Multiuser Configuration.

Multiuser

The Multiuser configuration provides multiple concurrent connections to a Graphic Hub (dongle
required). See Localhost, 5/4 Free, and Multiuser Configuration.

Main Server

The Main Server, as with the Multiuser configuration, provides multiple concurrent connections to
a Graphic Hub. The difference is that the Main Server provides a mirror service to a running a
Replication Server. In a failover situation, the system automatically redirects all clients from the
Main server to a Replication server (dongle required). See Cluster Configuration.

Replication Server

The Replication Server is use with the installation of a Main Server. A Replication Server is a
duplication of the Main server. See Cluster Configuration.

Replications in a Graphic Hub mean that every transaction on the primary server is immediately
mirrored on a Replication Server. In a failover situation, where the main server becomes
unavailable, the system automatically redirects all clients from the Main Server to the Replication
Server.

A failover situation occurs when one of the servers become unavailable due to hardware failure,
software errors, power loss, etc. A Main server crash results in a failover situation, where the Main
server switches to a Replication Server, in real-time.

On the Main server machine, the Graphic Hub Terminal shows Cluster Not Connected, and if the E-
mail functionality is enabled, one or more error E-mails are sent.

Usually, a Graphic Hub in a Cluster configuration runs in real-time replication. In cases of a
network overload, loss of another server in the Cluster, or other serious system instabilities, the
Graphic Hub automatically switches to Recovery Mode. This means that one server buffers all
necessary transactions, for example, saving files. The Graphic Hub then deploys these files to the
other server in the Cluster when the resources are available again. After 15 seconds of no
incoming transactions, the Graphic Hub switches to real-time replication again, and the data
structure is updated, so that it is reflected on both servers.

If clients were directed to another server than the primary, during the down-time, the clients are
re-directed to the primary server again.
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See Also

Graphic Hub Applications
Selecting a Graphic Hub Mode
General Database Information
Graphic Hub Naming Service

2.2.3 Selecting a Graphic Hub Mode

When a Graphic Hub is installed a mode must be selected. This section details information on the
different modes, to help with the selection. Depending on the mode which is to be installed, a
Graphic Hub license dongle may be required.

The Graphic Hub can be installed for a Cluster, Multi User or Single User:

Cluster
Multi User
Single User

Cluster

A Cluster installation is an installation with multiple servers for multiple clients to access a Graphic
Hub. To install a Graphic Hub as a Cluster, use the Main Server and Replication Server modes.

Multi User

The 5/4 Free and Multiuser configurations give access to multiple concurrent TCP/IP connections
to a Graphic Hub.

5/4 Free provides up to five connections and is recommended for sharing content in small
Viz Artist work-groups. For example, installations on laptops and single workstations. This
mode does not require a license dongle.

Multiuser provides up to 800 (if required) connections (dongle required) and is
recommended for all scalable Viz Artist work-groups. This mode requires a license dongle.

Single User

A Localhost configuration is a single connection to a Graphic Hub. This mode is for local Viz Artist
installations, without a permanent network connection, and without the requirement of a license
dongle. For example, installations on laptops and single workstations.

See Also

Graphic Hub Terminal
Graphic Hub Applications
Graphic Hub Modes

General Database Information
Graphic Hub Naming Service
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2.2.4 General Database Information

Viz Artist uses a database to store Elements that clients work with. The Elements can be of these
types, among others:

- Scenes

- Geometries
Materials

- Advanced materials
Images
Fonts

- Audio files

& Note: For more information about the various element types, see the Viz Artist User
Guide.

The individual elements are stored in the Graphic Hub data directory as files.

The database manages the files in terms of properties and Universally Unique Identifiers (UUIDs).
These are visualized in Graphic Hub Manager as folders and projects. These folders and projects
are only virtual, and cannot be treated in the same way as folders in Microsoft Windows.

Clients can work with and organize files through Viz Artist in a logical project and folder structure
provided by the database. Although each file can be listed in/referenced from more than one
folder, it resides in the database in a single instance. A checksum is calculated for each file, so
that duplicate files can be easily found (see Locate Duplicate Files).

This page contains the following topics:

File Properties
Projects and Folders
Links and References
Folder Links
File References
File Links
Keywords
Data Locking

- Session Lock
Check Out

- Access Rights

File Properties

Various properties are associated to each individual file in the database, for example:

Properties Properties (continued)

NamePathFile typeFile sizeChecksum UUIDRightsKeywordsFile-linksReferences
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For more information about the properties, see Working with Files.

Projects and Folders

The database is able to maintain a logical structure composed of projects and folders. This helps
Viz Artist users to keep an overview of the files they work on. The tree of folders is only virtual, the
files are not actually stored on the hard disk with such a structure. All the folders a file is shown
in, are stored in the properties of the file. The main benefit of this virtual structure is that the file
itself is stored only once in the database, with links to it. The hard disk space is then kept low and
the administration of files is much easier.

Links and References

In the database, files are linked and referenced. Every file knows which folder it is placed in, which
other files it uses, and also by which other files it is used. For example, in a scene, fonts and
images are used. If one of the files that are used in the scene changes, the scene uses the file in its
new state. Every file holds a list of links and references in its properties.

Three types of links and references are handled by the database: folder-links, file-references, and
file-links.

Folder Links

B Every file in the database holds information about the folders it is placed in. These entries are
called folder-links. Each file can hold as many folder-links as necessary. The file is physically stored
in the database only once, but it can be virtually available in various folders. The UUID of the file is
identical in all folders. If a file is deleted within a folder, only the folder-link to this folder is
removed. The file remains in the database, unless every folder-link is removed. When the last
folder-link is removed, the file is deleted from the database.

& In the Explorer, a file that holds more than one folder-link is shown as an icon with an arrow.

File References

In everyday use, it is necessary for a file to reference other files. For example, a scene can contain
images. The root file must be linked to all the files it uses. The file-reference feature keeps track of
all other files being used by this file.

File Links

In everyday use, it is also necessary for a file to be referenced by other files. The root file must be
linked to all the files it is used by. The file-links feature keeps track of all other files the file is used
by.

Keywords

To help users organize their work, keywords can be applied to files. Up to 20 keywords can be
applied to each file. Every file holds a list of keywords in its properties.
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@ Tip: Keywords can be used as a database search criteria.

Data Locking

Three different types of data locking exist within the database: session lock, check out, and access
rights.

Session Lock

As long as the session lock is active, only the user who has locked the file is able to save it in the
database. Other users can only view the file. A locked file is marked in Viz Artist and Graphic Hub
Manager (if the files view type is set to icons) with a keyhole icon.

A session lock is automatically applied to a file when a user opens it in Viz Artist. The session lock
is removed once the file is closed. A session lock is valid as long as the user who has locked the
file is connected to the server. When the user disconnects, the lock is opened. To end a session
lock, the user who locked it, or the administrator, can manually unlock it.

Check Out

As long as the check out is active, only the user who has checked out the file is able to save it in
the database. Other users can just view the file. A checked out file is marked in Viz Artist and
Graphic Hub Manager (if the files view type is set to icons) with a stop icon.

Every file in the database can be checked out. The check out of a file is valid until it is checked in
again. Check in can be performed by the user who checked out the file, or the check out can be
canceled by the administrator.

Access Rights

The database is able to maintain rights on files and folders. Individual rights for user, group, and
world can be set either to allow or disallow reading and/or writing rights.

© IMPORTANT! Viz Artist 3.3.x cannot handle access rights. It is strongly inadvisable to make
changes in the server that may impact work on the clients.

User: Sets the rights for the owner of a file or folder.
Group: Sets the rights for all the members of the group the owner belongs to.
- World: Sets the rights for all database users.

See Also

User and Group Management
Graphic Hub Applications
Graphic Hub Modes

Graphic Hub Naming Service
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2.2.5 Graphic Hub Naming Service

There can be many Graphic Hubs running on the same network. A Graphic Hub Naming Service is
used to monitor and keep track of all servers on the network. The Graphic Hub server cannot run
without a Naming Service.

A Naming Service can be started together with a server, or the Graphic Hub server can connect to a
naming service on the network. When a server configured with this naming server is started, the
remote Naming Service is informed. The Naming Service is aware that the Graphic Hub server is
available for client connections.

The Naming Service application is started and shut down from the Graphic Hub Terminal. The port
used for the communication between the Naming Service and the clients can be defined in the
terminal before startup.

When a Graphic Hub server is bound to an already running Naming Service, the server name must
be unique. If a server with the same name is already running, the Graphic Hub exits with an error.
The exit code and error message are written to the log file.

& Note: Server names are case sensitive.

To avoid having a single point of failure for Main and Replication server configurations, each
instance must have its own separate Naming Service.

© IMPORTANT! The server's network adapter statuses and IP addresses cannot be changed
while the Graphic Hub or the Naming Service are running.

Supported Configurations

Both the Graphic Hub Naming Service and a Graphic Hub can run independently of each other,
even on separate physical machines. The following two configuration scenarios are supported:

Each Server Connected to its own Naming Service
Multiple Servers Connected to one Naming Service

Each Server Connected to its own Naming Service

In this type of configuration, the clients are able to connect to only one server. Such a
configuration is used when working in single-user mode. In single-user mode, the server, Naming
Service, and all other Viz 3 products that connect to the database must be installed on the same
physical machine. As the server is working on the “localhost” in this configuration, other clients
cannot see the Naming Service or server.

© IMPORTANT! Although a localhost can never be accessed from client applications such as
Viz Artist, it is possible to monitor and start/stop localhost servers/naming services by
enabling this in the Graphic Hub Manager.

This type of configuration is typically used when working on a stand-alone computer.

Copyright © 2023 Vizrt Page 46



Graphic Hub Administrator Guide - 3.8

Multiple Servers Connected to one Naming Service

In this type of configuration, the clients are able to connect to all servers managed by the defined
Naming Service. In multi-user mode, the server and Naming Service are available to all clients in
the network. The Naming Service uses the host name of the computer it runs on as its name. By
default, the name of the server is Graphic Hub, but this can be modified in Graphic Hub Terminal
before startup (see Graphic Hub Terminal).

© IMPORTANT! Scheduled tasks do not trigger when the Graphic Hub and Naming Service are
not running on the same host (Naming Service only mode)!

See Also

- Graphic Hub Applications
- Graphic Hub Modes
- General Database Information

2.3 Security Advisory

2.3.1 Recommendations
After installation of the software, please proceed with the following advisories:

- Change the default password for Graphic Hub Admin user: GH Manager Tools > Administer
users & groups.
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Enable http authentication in GH Terminal: Options > Advanced Settings.

- Change Graphic Hub Terminal password (see above): Options > Change Terminal password.
Use SSL encryption for Graphic Hub Rest.
Disable Remote Access for WiBu Codemeter Webadmin and use SSL (Configuration > Basic >
Webadmin)
Remove any unneeded services.

2.3.2 Ports used by Graphic Hub and Components

The Graphic Hub server requires a limited number of open network ports. The following table lists
the ports used for Graphic Hub server connectivity:

Port Number Protocol Used for
Other components

427 TCP, UDP OpenSLP
22352 TCP, UDP Codemeter

Graphic Hub & Graphic Hub Terminal

19394 ubp Manager for Terminal 2
19395 TCP Terminal 2

19396 TCP, UDP Naming service

19397 TCP, UDP Graphic Hub

19399 (configurable) TCP Terminal 3 (HTTP)

Graphic Hub REST Service

19398 (configurable) TCP REST service (HTTP)

Deploy Agent

19391 TCP, UDP Deploy Agent High Availability
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19392 ubP Deploy Agent
19393 TCP Deploy Agent
ImEx Agent

19390 (configurable) TCP ImEx Agent (HTTP)

Additional Ranges

Since Graphic Hub Deploy Agent 2, Graphic Hub Manager 5, GH REST 2, and Viz Artist 3.8.2, these
clients do not require any port exemption rules on the client side firewall configuration. However,
for earlier versions, all ports must be open on the client side.

2.4 Startup And Shutdown

This section details the startup and shutdown procedures for the Graphic Hub, the Graphic Hub
Manager and servers.

This section contains information on the following topics:

- Graphic Hub Startup
- Graphic Hub Shut Down
- Graphic Hub Emergency Shutdown

2.4.1 Graphic Hub Startup

This section details the procedures to start and shutdown the Graphic Hub and the startup of a
configured Graphic Hub database. All Graphic Hub configurations are started through the Graphic
Hub Terminal.

To log in and use a Graphic Hub, see Graphic Hub Login and Log Out.

To Start a Graphic Hub

1. Open the Graphic Hub Terminal:
- Click Start > All Programs > Vizrt > Graphic Hub > GH Terminal, or
Double-click the Graphic Hub Terminal desktop icon. The Graphic Hub Terminal opens
in the default web browser.

Copyright © 2023 Vizrt Page 49



Graphic Hub Administrator Guide -

& Note: Each time the Viz GH Terminal desktop icon is double-clicked a new
Graphic Hub Terminal instance is opened.

2. Start a Graphic Hub Server:

a.
b.

. Click Load and run configuration > Select configuration.

The last used server configuration is available.
Click Start Server.

or

Click Mode.

. Select the required Graphic Hub mode (see Graphic Hub Modes and Selecting a

Graphic Hub Mode).

5rd free Load configuratkon
Muliuser Load and run -:-:-nﬁg'urd'.l-:-n VizDibSeEn,
Cluster

Create new configuration

MNaming service only

[:I.rr::_'r_nr‘.' .ﬁ..g.t_'.'*. ondy

& Note: From the same menu, select Load Configuration to load and modify a
configuration. Then start that configuration.

3.8
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Localhost, 5/4 Free and Multiuser Startup Screen

< Graphic Hub Terminal - GHServer

Cluster Startup Screen

= Graphic Hub Terminal - GH-MAIMN
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2.4.2 Graphic Hub Shut Down

This section details the options for shut down of one or more Graphic Hubs, without the
requirement to log off completely or exit the Graphic Hub Manager.

Shutdown options are:

- A normal shutdown: Through the Graphic Hub Manager.
- A scheduled normal shutdown: A scheduled shutdown can be configured in the Graphic Hub

Terminal or the Graphic Hub Manager.

- A Cluster configuration shutdown: For system maintenance or network configuration work in

a Cluster system, the best type of shutdown operation is to shut down the Cluster, through
the Graphic Hub Manager.
It is also possible to Limit and Shut Down Sessions.

A Graphic Hub is shut down from the Graphic Hub Manager.

& Note: In emergency situations, you can shut down the Graphic Hub using the Graphic Hub

Terminal (see Graphic Hub Emergency Shutdown).

A normal shutdown operation takes much longer than an Emergency Shutdown, but is far safer for
data retention.

This page contains the following topics and procedures:

- To Do a Normal Shutdown

- To Schedule a Server Shutdown Using Graphic Hub Terminal
- To Schedule a Server Shutdown Using Graphic Hub Manager
- To Shut Down a Cluster

Limit and Shut Down Sessions
- To Limit the Number of Sessions
- To Disconnect a Selected Session

To Do a Normal Shutdown

1.

(9]

In the Graphic Hub Manager open the Server Shutdown panel:
- Click Server > Shutdown..., or press CTRL + W or F10.
In the Server drop-down box, select the server to shutdown.

. Option: Send a message to all users of the server:

a. In the Message field write a message to all users of this server to inform them that the
server is about to be shut down.
b. Click Send.
Click Shutdown.
Click Yes.
Click Close.
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To Schedule a Server Shutdown Using Graphic Hub Terminal

A WN—

N

Open Graphic Hub Terminal and go to Options > Scheduled Tasks.
Select the Shutdown task.

Check the Schedule shutdown box.

Select a Mode:

Once.
Recurring.
Recurring forever.

. Select a Start at and End after date.

& Note: A shutdown task cannot be started in the past.

If Mode is set to Recurring or Recurring forever, set the interval in Each.
Set a Notification time. Options are:
Do not notify at all.
- Just notify five minutes before shutdown.
Notify 15 minutes before - every five minutes.
Notify 30 minutes before - every 10 minutes (but at least five minutes before).
Notify 60 minutes before - every 15 minutes (but at least five minutes before).

The Info line confirms the next scheduled shutdown time.

To Schedule a Server Shutdown Using Graphic Hub Manager

1.

2.

3.

4.
5.

In the Graphic Hub Manager open the Server Shutdown panel:
Click Server > Shutdown, or
Press CTRL + W or F10.

Click Schedule...

x|
IREi:urring j
|E.f 7/2016 10:32:00 AM | End afier: [10/ 1/2016 10:32:00 AM ]|
Each: I 1 Iday[s:l j
Motification: INDﬁf’y 30 minutes before - every 10 minutes (and 5 min. before) j

Info:  21h, 21m, 34s (Thursday, September 08, 2016 10:32:00 AM)

QK I Cancel |

In the Mode drop down box, select one of these options:
Once.
Recurring.
Recurring forever.

In the Start at drop down box, click to select a date from the calendar.
If required, adjust the time.
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& Note: Schedule tasks can not begin the past.

6. If Recurring is selected:
a. In the End after drop down box, click to select a date from the calendar.

b. If required set a time.
7. Select a Notification option. Options are:
Do not notify at all.
- Just notify five minutes before shutdown.
Notify 15 minutes before - every five minutes.
Notify 30 minutes before - every 10 minutes (but at least five minutes before).
Notify 60 minutes before - every 15 minutes (but at least five minutes before).

8. Click OK.

To Shut Down a Cluster

1. In the Graphic Hub Manager, log in to the Main server.
2. Open the Server Shutdown panel:
- Click Server > Shutdown, or
Press CTRL + W or F10.
3. Click Shutdown Cluster.

Limit and Shut Down Sessions

Active sessions on the server can be limited by the limitation of the number and/or shut down of
individual sessions. If a Graphic Hub is to be shutdown, clients can be notified (message, email,
walk-in, etc.) and then not allow them to reconnect (no new connections = nobody is removed, but

nobody new can come in).
A limit of one connection can be set, if only a Deploy Agent is used.

A disconnect stops client access immediately.

To Limit the Number of Sessions

1. In the Graphic Hub Manager open the Server Shutdown panel:
Click Server > Shutdown, or

Press CTRL + W or F10.
2. Select a server in the Server drop-down box.
3. Click Modify...
Session limit for server 'GHMainServerE

Lirnit: =System default=

4. Select one of the following options:
- System default
User defined (and enter a numerical value)
No new connections
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No new connections (except Graphic Hub Deploy)
5. Click OK.

To Disconnect a Selected Session

1. In the Graphic Hub Manager open the Server Shutdown panel:
- Click Server > Shutdown, or
Press CTRL+ W or F10.
Select a session, or sessions, in the Sessions list.
Right-click and select Disconnect selected sessions...
Click Disconnect.
Click Close.

uTh WN

2.4.3 Graphic Hub Emergency Shutdown

A Graphic Hub emergency shutdown terminates a Graphic Hub almost immediately. If the Graphic
Hub server is a Main server in a Replication environment, the emergency shutdown causes a
failover to the Replication server.

© Warning: Index re-organization and vacuum of tables is skipped when performing an
emergency shutdown. Please perform a normal shutdown through GH Manager to avoid
performance reduction and to free disk space.

Emergency shutdowns can only be executed from the Graphic Hub Terminal, and should be used
sparingly.
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To Do an Emergency Shutdown

1. ency Shutdown.

In the Graphic Hub Terminal main window, click Emerg

GHS
Viz
ode: 5/4 Free

Version: 3.0.0

Maming service status: Running
Server status Running
Data path:

Shutdown task:

Automi

Journal level: Warnings

Emergency Shutdown

Snow Configuration

Show GH Log

2. To continue with the emergency shutdown, click Yes.

Emergency Shutdown

A Are you sure you want to perform an emergency
shutdown?

Note: An automatic backup after shutdown is configured!

Temp: sable backup after sh

& Note: If an automatic backup has been configured this warning message shows.
Check the checkbox to disable an automatic backup on this emergency shutdown.

See Also
Graphic Hub Startup
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- Graphic Hub Shut Down
Backup and Restore

2.5 Database Management

& Note: For Pilot data back end systems using Deploy Agent 2.2.0 or later and GH Manager
5.2.0 or later, it is recommended to backup Pilot data using Pilot data deploy tasks,
see Resolve Viz Pilot Data Differences Between Graphic Hubs.

This section contains information on the following topics:

Main and Replication Servers with Failover
User and Group Management
- Test a Replication Server
Data Errors
Import External Images
- Locate Duplicate Files
- Add Metadata
Replace File References
- Direct Deploy Copy
- Graphic Hub Search
Server Information
Daily Backup Using a Second Graphic Hub
Detect and Solve Server Differences

2.5.1 Main and Replication Servers with Failover

Adding failover servers adds another level of redundancy to the Graphic Hub cluster. This is useful
in situations in which the cluster becomes unavailable, for example due to maintenance or
hardware failure. This section describes how to configure a Graphic Hub cluster with an arbitrary
number of failover servers in multiuser mode, and contains the following information:
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Graphic Hub {Main) Graphic Hub [Replication)

GH Deploy Agent
with real-time deploy task

Graphic Hub (Multiuser)
as failover server

Wiz Artist/Engine

GH Deploy Agent
with real-tirme deploy task

Graphic Hub (Multiuser)
as failover server 2

To Configure a Cluster with Failover Servers

Perform a Cluster Server Installation, setting up both the Main and Replication server.

Install the number of Graphic Hubs to act as failover server in multiuser mode. The failover
server has to be able to handle the number of clients connected to the cluster, in case the
cluster becomes unavailable.

Set up one or more Deploy Agents with real time deployment from the Main server to the
failover server(s).

Create a corresponding amount of real time deploy tasks from the cluster to the failover
servers to keep them in sync. In setups using multiple failover servers, the recommended
configuration is to deploy from the Main server in the cluster to the first failover server, then
from the first failover server to the second failover server, etc.

In the Deploy Agent Properties, open the Configuration Panel and configure enable
emergency pause of real time tasks in the case of deletion of 1% of all objects or 1 item.
This prevents the deploy task on the cluster from accidentally deleting content created while
the cluster has been unavailable, in case the cluster becomes available again.
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@ Tip: Shut down the Deploy Agent service on the cluster before restarting the cluster. This
makes sure nothing gets deleted or overwritten when the cluster is brought back up.

Configure the clients, such as Viz Artist or GH REST, to use one or multiple of the failover
multiuser servers. If the cluster becomes available, the clients only connect to the failover
servers if the client is configured correctly. For details on configuring the client for failover,
refer to the respective product documentation.

To Check Client Connections

1. Log on to the cluster and the failover server(s) with Graphic Hub Manager.
2. Open the Active sessions window. This provides an overview of all logged in users and active
sessions, and to which host they are connected.

Resume Normal Operation after Failure of Main or Whole Cluster

After a failure of the main server, all clients are automatically redirected to the replication server.
When the cluster has returned to real time replication mode, the clients are automatically returned
to the Main server.

After a failure of the cluster, all clients are automatically redirected to the failover server(s).
However, they do not automatically return to the cluster once the cluster has been brought back
online. Before bringing the clients back to the cluster, a manual merge of the data from the
failover server is needed to re-synchronize the cluster. This is required in order to avoid possible
loss of data created by the clients during the cluster downtime period.

Before restarting the Deploy Agent service after the cluster is back up, make sure that the server
differences have been successfully merged, and that all clients are back on the cluster again.

See Also

System Installation
Graphic Hub Terminal
Graphic Hub Manager
Graphic Hub Deploy Agent

2.5.2 User and Group Management

From the Administer Users and Administer Groups windows it is possible to manage all the users
and groups in Graphic Hub.

Every user that works with the Graphic Hub, either directly or from a client application, must:

Have their own user profile.
Belong to a Group.

The User and Group management system monitors who creates files, who owns files, and who has
rights to modify the various files in the Graphic Hub.

The permission settings on group level are the default settings for all assigned users, but it is
possible to change the permission on user level afterwards. It is possible that one specific user has
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more or less permissions as the original defined base permission settings of the underlying group
(like a super-user or restricted user).

User and Group permission settings are always related to a folder or file permission setting.

(@ Example: User 1 of Group A has, on User and Group level, ‘no world write rights’ activated.
This means that it is not possible to override or delete a file or folder which is owned by
another User from a different Group.

(@ Example: User 2 of Group A has, on Group level, 'group write rights' activated but not on
User level (restricted user). This means that User 2 is only permitted to overwrite or delete
their own files in their own folder structure.

Groups

To Open the Administer Groups Window

Click Tools > Administer Users and Groups > Administer groups.

& Note: All Graphic Hub Manager users can view Users and Groups. Only an
administrator can create new Users or Groups, or modify existing ones

_u_u

VizDbServer SERVER[ADmINg) ™1 | NHew.. | View

Server | Mame I Active I Access ﬁm{g@mj |
VizDbServer@GHSERYER Adrninlstr stor Yes WO W 1
YizDbServer@GEHSERYER Guest e W 9904

2 groups on server VizDbServer@ GHSERVER'

To Create a New Group

1. Open the Administer Groups window.

Copyright © 2023 Vizrt Page 60



2.

No

8.

Graphic Hub Administrator Guide - 3.8

Select New... or right click and select Create new group... from the context menu.

New group ‘NewGroup' on server "YizDb! x|

SErver: I'-.-'izDI:uServer@GHSERVER(.ﬁ.dmin} j
ID: I [autogenerated]

Ackive: ¥ Active group

Mame: I MewGroup

Arccess rights:
Idser rights: ¥ Read W irite
Group rights: ¥ Read W irite
World rights: ¥ Read W irite

(04 I Zancel |

&

. Select the destination server from the Server drop down box.

& Note: If the group-list is filtered, the server cannot be changed.

The new group ID value is automatically generated.

. Check or uncheck the Active box to make the new group active or inactive.

& Note: If a group is inactive, no members can be added.

In the Name box give the new group a unique name.

Specify the user account access rights:
User rights: User may overwrite their files and create files.
Group rights: User can overwrite files which belong to the group, of which they are a
member of.

World rights: User may overwrite files which belong to anyone.
Click OK.

To Edit a Group

f—

Note: Only available with administrator privileges and with a single server selected.

. Open the Administer Groups window.

Right click and select Edit selected group... from the context menu.

. Check the Active box to make the new group active, if required. If changed from active to

inactive or inactive to active the modified check box is checked. If the modified check box is
unchecked, the change is ignored.

& Note: You cannot add members to inactive groups.
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4. In the Name box enter a new unique group name, if required. If changes are made in the
text box the modified check box is checked. If the modified check box is unchecked, the
change is ignored.

5. Specify the user account access rights, if required:

User rights: User may overwrite their files and create files.

- Group rights: User can overwrite files which belong to the group, of which they are a
member of.

- World rights: User may overwrite files which belong to anyone.

Click the View member button to see all the group members
Click OK.

No

To Delete One or Multiple Groups
Administrators can delete groups that do not contain members.

1. Open the Administer Groups window.

2. Select the Group or Groups to be delete. Select a Group, or hold CTRL to select multiple
groups.

3. Press Delete.

4. Click OK.

To View a Group

& Note: Only available if logged in with no Administration rights or if there are multiple
users, over different servers.

1. Open the Administer Groups window.
2. Click on the group or groups to be viewed.
3. Right click and select View selected group... from the context menu.
4. The Group window opens. No files can be edited.
5. Click the View member button to see all the group members
6. Click Close.
Users

To Open the Administer Users Window

- Click Tools > Administer Users and Groups > Administer users... , or
Press CTRL + F9, or
Press CTRL + U.
The Users window shows all available users on all active servers.

& Note: To narrow the users list first select a Server then select a Group from the Server and
Group drop down boxes.
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sers | ‘]DJEI
VigDoServer GHIERVER A drman) "'I all greupt | Hew. Y elel

Sarver [ [ Full s [erop [actrn | Accmssrights s [« |

VDb ServnDGHIERYER Adrrin Feckririsiraton Adrriristrator Yo W W 1

WieDbSer e GHIERVER Guest Doef ik -LUbser Gusesh es W W b

Fusers on server VizDESerrenG GHSERVER"

To Create a New User Account

1. Open the Administer Users window.

2. Select either:
New...
Right click, and click Create new user... from the context menu,
Press F6 or Insert.

New user ‘NewlUser' on server '¥izDbServer@t x|
SErver: I'u'izDI:uServer@GHSERVER(.ﬁ.dmin} j
ID: I [autogenerated]

Ackive: ¥ activate account

Sroup; I.ﬁ.dministratur j
Mickname: I Mewlser

Fullname: I Mew Lser

Password; I I ITTTT T

Re-enter passward: I TTITIT

Arccess rights:
Iser rights: ¥ Read W irite

Graup rights; ¥ Read W irite
wiorld rights: ¥ Read W irite

Ik I Zancel |

P
3. Select the destination server from the Server drop down box.

& Note: If the user list shows users of one server only, the server is preset and cannot
be changed.

4. The new group ID value is automatically generated.
5. Check or uncheck the Active box to make the new user account active or inactive.
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& Note: If the user account is inactive, the user cannot log in or work with the files in
the database.

In the Group box select which group the new user belong too.

A Note: If user list is filtered to show only users of a specific group, this group is
preset and cannot be changed.

In the Nickname box, give the new user a unique nickname.
In the Full name box, enter the new user’s full name.
Enter a user Password. Repeat the password in the Re-enter the password box.

& Note: Leave both the Password and Re-enter password boxes empty if no password
is required.

Specify the new user account access rights:
User rights: User may overwrite their files and create files.
Group rights: User can overwrite files which belong to the group, of which they are a
member of.

- World rights: User may overwrite files which belong to anyone.
Click OK.

To Edit a User Account

& Note: Only available with administrator privileges.

1.

Open the Administer Users window.
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Select Edit... or right click and select Edit selected user... from the context menu.

User 'MewUserl" on server "VizDbServerE x|

SErver: I'u'izDI:uServer@GHSERVER(.ﬁ.dmin} j

1D | 1697

Ackive: [T ¥ activate account
Group: i |Guest |
Mickname: v I Mewllserl
Fullmame: v I Mew Llser 1
Password: il | sassnes
Re-enter passward: I

fccess rights: v

Iser rights: ¥ Read W irite

Graup rights; ¥ Read [~ irite
wiorld rights: ¥ Read [ irite

Miz user sethings:  [none] Delete viz user sethings.. . |

K I Zancel |

4

The user account Server cannot be changed.
The user account ID value cannot be changed.

. Check or uncheck the Active box to make the new user account active or inactive, if

required.

& Note: If user account is inactive, the user cannot log in or work with the files in the
database.

In the Group box select the group the user account belongs too, if required.

In the Nickname box give the user a new unique nickname, if required.

In the Full name box change the user’s full name, if required.

Enter a new user Password, if required. Repeat the password in the Re-enter the password
box.

A Note: Leave both the Password and Re-enter password boxes empty if no password
is required.

Change the user account access rights, if required:
User rights: User may overwrite their files and create files.
Group rights: User can overwrite files which belong to the group, of which they are a
member of.
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World rights: User may overwrite files which belong to anyone.
11. If required, click the Delete viz user settings button to delete the user account settings
which are, by default, saved together with the user profile.

A Note: Delete viz user settings is only available if one user is to be edited. If more
than one user is selected, this button does not show.

12. Click OK.
To Delete a User Account

& Note: Only available with administrator privileges.

& Note: The built-in administrator cannot be deleted.

1. Open the Administer Users window.
2. Click the User(s) to be deleted (press CTRL and click to multi select).

& Note: Users on multiple servers cannot be deleted in one step.

3. Select either:
Delete... or
Right-click on the selection and click Delete selected users..., or
Press DELETE.
4. Click OK.
A User cannot be deleted if they own an object(s) in the Graphic Hub. If a User to be deleted
owns any objects the Choose user... window opens when OK is clicked on. Use this window
to transfer object ownership to another User.

The user "Guest’ still owns objects (projects/folders)files) on
server WizDbServen@iEHSERVER,

! " Before you can delete "Guest', wou must change the
ownership of those objects to another user!

Select the user, who will gain ownership of all objects, belonging to
user 'Guest’,

ser:  |Admin j

Mote: An action-log window will open to perform this owner change.

IMPORTAMT: ¥ou need ko execute and close the set-owner action-log
before vou can proceed with deleting the user 'Guest']

(o] 4 I Cancel

5. In the Choose user... window select the User to be assigned the object(s), from the drop
down box.
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6. Click OK to open the Setting owner... window.

Setting owner... {on server 'VizDbServer@GHSERVER") . =1 Dlﬂ
File | ownertoset | Info
sas IMAYEZ Admin Not yet processed!
eas IMaged Admin Mot vet processed!
4| | 2
[ Close this window automatically i no problems ocourred r{}\ I e I Cancel I
¥ Reuse this window For same actions -
¥ Do not insert entries that are slready inthe sl [ Warn me about nok inserbed
i2 entries to be processed, | | &

© IMPORTANT! The Choose user... window puts all objects, of the selected User, in an
Action Log window (Setting owner...), where ownership changes.

. Click Set owner.
Click Close.

®© N

© IMPORTANT! The owner change must be done before delete can continue. If the User
still owns an object(s), the delete fails.

To View a User Account

A Note: Only available if logged in with no Administration rights or if there are multiple
users, over different servers.

f—

. Open the Administer Users window.
2. Click on the user or user’s accounts to be viewed.
3. Select either:

- View... or
Right click and select View selected user... from the context menu, or
Click on a user account and press F4.
4. The User window opens. No files can be edited.

2.5.3 Test a Replication Server

This section details how to check a running replication server, including failover. It is strongly
recommended that the replication server is tested in a production environment.
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© IMPORTANT! Before a test, make sure that no clients are working on any of the servers in
the Cluster. Also, check that the Graphic Hub solution is a fresh setup of a Replication
Cluster.

To Test a Replication Server

1. From a third computer, start the Graphic Hub Manager and log on to both the Main and
Replication server as administrator.

| General [
e Add-Ons .

data

Frajec
_—

(7B08E09-4567-ACEE -QC2944BE04 0 BE041

data

.Guasl b
Tuesday, Sugust 23, 2009 120113 PH

[+ Wirite
roup righks [=] it
[=] white:

| ok || cece |

2. Open the properties of the data directory on both machines (right-click the data folder, and
then from the menu that shows, select Properties), and make sure that the UUIDs on both
machines are identical. If they are not identical, shut down the servers.

a. If the data directories on both the Main and Replication servers are empty, delete both
data directories. Use the Graphic Hub Terminal to create new data directories on both
servers, then start the cluster.

b. If the data directory is not empty, delete the data directory on the Replication server
only. Copy the data directory from the Main server to the Replication server. Use the
Graphic Hub Terminal to configure the copied data directory as a new data directory
for the Replication server, then start the server. To use the data directory on the
Replication server as data directory for the cluster, repeat the above steps copying the
data directory from the Replication server to the Main server, and configure the main
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server with the copied data directory.

Monitor servers

- B GHMainServer@isH-MATH Dverview of server 'GHMainServer@GH-MAIN' (M
—Cwveryiew — [ Disk
@ Disk Total; 53.00 GB
@ Memory Ised; 36.03 GB
i@ License Free: 21,92 Gh
& Health Free %: 37.79 %
@ Cluster Lirnit: Q.77 GE
~License ~Health
Expires; Deadlocks; 1]
In 176 days. Ackive sessions: &
File opens: 1]
Files: 1]
I—I_ Files in mernarsy: 1]
Details... Open transactions: 1]

In Graphic Hub Manager, select Tools > Monitor Servers . Check that the Health LED is green.
From the main menu, select View > Messages (Chat) .

. Unplug the network cable on the main machine, and then wait for a few seconds.

et
l{'!fﬂji'ﬂlé- 11234154 A= [iz GH Managér | 'GHvainServerBGH-MAIN it down! Beconnadcted bo replcstion server 'GHReplc stionServsndaH-REPLICATION |

The Graphic Hub Manager chat panel should show that the main server is down and that the
replication server has automatically taken over.

/U'E'g Servers and folders\(:'u_‘{ Search\
= n 1 - GHMainSeryer@EH-MATMN Admind
e data

The main server name in the Servers and Folders should also be colored red.

Plug the network cable in on the main machine again. To prevent data loss and
configuration corruptions in the cluster environment, the main server should shut down.
Wait for the shutdown to complete, and then start the main server from the Graphic Hub
Terminal.

If no users have been working with the system while the main server was down, proceed to
the next step. Otherwise, wait a minute or two for the system to refresh.

The Graphic Hub Manager chat panel should now show that the main server is up and
running again, and that the main server has automatically taken over as the primary server

in the cluster.

Magmges:
| S{BI2016 1 1:34:54 AM> [Viz G4 Manager]: ‘GHManGerver fGH-MAIN s downi! Reconnected bo replcation server ‘GRephationServerfGH-REPLICATION'| .
[ciEiz0e 113554 AM> [viz G Manager |: ‘GHManServerPGH-MAIN b girvn s Reconnecbed back From rephcation server GHRechostiorServer@aH-REFLICATICN |

If the steps above have been carried through correctly, the cluster configuration has been
tested sufficiently and is ready to work in a real production environment.
Query the Journal log for replication-related errors.

2.5.4 Data Errors

Like the Check Disk feature in Windows, Graphic Hub Manager allows the database administrator
to search for and repair data errors in the Graphic Hub.
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The Server Check menu is used to scan for errors and inconsistencies in the server’s internal
structure. Various checks are available, and can be set On or Off as required. Any errors
discovered during the check are displayed with a description of the errors and how they possibly

can be resolved. Some types of errors must be fixed manually, while others can be fixed
automatically. This is displayed in the list of errors.

After finishing or canceling a server check, results can be exported to a file or copied to the
clipboard from the error list context menu. If the process is paused, it is not be possible to check
the file properties, or to copy or export the results.

& Note: Server Check requires Administrator user rights.

To Find Data Errors

1. Open the Check Server window.

2. In the Servers and Folder panel, right-click the server to be checked and select Check server
<server name>

Fo o

Collapse
Expand completely
Collapse completely

Mew 2

Rename Chri+H ||l F#

Search in "VizDbServer @GHSERVER'. .. Cirl+S | Ctrl+F [F3

[, P Heli= Gy ;
o [y A ey p

Lepioy. ., Chrl40
I Chedk server "VizDbServer @GHSERVER'... I
£ Import from archive... shift+Ctrl+A

Enable server "VizDbServer @GHSERVER' for Auto lagin...
Set text color for server 'VizDbServer @GHSERVER'. ..

Logout from server "VizDbServer @GHSERVER'...

) Properties. ..

3. In the left panel, choose the options to check for.

& Note: If this window was opened with Server > Check, select the server to be checked
from the Server drop-down box.

Options are:
Check folder links
Check file links

Check references
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Check folders
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™
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. Click the Check button. You are advised that checking for data errors can be time
consuming and resource heavy, and should not be done at peak hours.

Server check: Server load and time consumption x|

) Make:

Checking the database stresses the server and therefore should
not be performed at crikical times.

Also be aware that the check routine may take a long time
(depending on the database size and the check options wou
selecked.)

¥ou may though pause or cancel the server check at any time,

Are wou sure you wank to check this server now?
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5. Click Yes to proceed. Any errors found are shown in the right panel. Clicking on an error
shows more detailed information in the bottom panel.
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To Fix Data Errors

1. If you do not require a log of errors that have been fixed, check Automatically remove fixed
entries.
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2. Click the Fix all! button.
A Note: You also have the option of selecting only certain errors in the right panel,

right-clicking, and fixing only the selected entries or trying to Verify and Restore
files.
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s 2 all_del SCEME 0.00KB File int
Eiimg_2_del TMARF nnnkKR  Filsint
Fix 1 entry
Verify,/restore...

Copy to clipboard
Export to file...

L4

File integrity error(s) & : Fold Properties...

3. Any errors that cannot be fixed remain in the right panel. Click the entry and follow the
instructions in the bottom panel.
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& Note: Checksum 11 means that a client failed (disconnected/crashed) during a Save
operation. The Graphic Hub still has the old content and clients can load this old content,
but to indicate that the scene was not saved correctly the checksum is set to 11. To reset
this state and clean up temporary data of the failed Save operation, open the affected file
in Viz Artist and save it.

2.5.5 Import External Images

External images can be imported from Windows Explorer directly into a connected Graphic Hub

using Graphic Hub Manager. It is recommended that imported images are of sufficient quality to
be worked on in Viz Artist. However, you do have the option to compress images when they are
imported.

To Import External Images

1. Select one or more images in Windows Explorer.
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2. Drag the selected images to a folder or the explore panel.
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3. Select the import settings:

Import images

Image compression: | Select automatically ~

Image guality: LOwW w

Import bilevel matte type images as RGBA
Overwrite existing images (with same name)

2items to import

Cance

Image Compression: Set the default image compression during import. The following
options are available:

None: No compression.

Select automatically: If the source image has an alpha channel, DXT5 is used. If the

source image does not have an alpha channel, DXT1 is used.

DXT1: Works best on images without an alpha channel.

DXT5: Works best on images with an alpha channel.

Import quality: The quality defines the compression for .png and .jpg images.

Import bilevel matte type images as RGBA: Applies to monochrome images only. When set, the
luminance of monochrome images is treated as an alpha channel. When disabled, the alpha
channel is treated as RGBA, while images without alpha channel are treated as RGB.

Overwrite existing images: Check this checkbox to overwrite images with duplicate file names in
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the target directory during import. Otherwise, an extension to the file name is added to the newly
imported images.

1. Click Import. This opens the Import external files window:
Import external files... (on server 'VizDbServer@LOCALHOST)

Path Mame Type Size  Target folder

ves Ci\Usersifor\OneDrive - Vizrt Gro... artleo.com-40225 jpg 924,71KE data/BILD_MCR.
ves C2YUsersifbr\OneDrive - Vizrt Gro... artleo.com-39534  jpg 1011,79... data/BILD_MCR

£ >

[]close this window automatically if no problems occurred ynt Cancel

Reuse this window for same actions
Do not insert entries that are already in the list Warn me about not inserted

2 entries to be processed.

2. Set the desired options for the import by checking the appropriate checkboxes, and click
Import to perform the operation.

3. After the import process has finished, the results can be investigated in the main section of
the import window. Any files that failed to import are marked with a red cross next to the

path. If an image fails to import, verify that it is among the supported image formats for
import.

@ Tip: Importing images to the Graphic Hub using Viz Artist support a wider range of
file formats.

4. Click Close to close the import window.

Graphic Hub Manager Supported Image Formats for Import

The following image formats are supported for direct import using the Graphic Hub Manager and
GH REST upload:

File Type Note

.bmp
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File Type Note

.gif

Jpg

.png

.tga No alpha 32

tiff No CMYK and LAB

.exr

.hdr

2.5.6 Locate Duplicate Files

When files are copied from one folder to another, such as when creating linked or duplicate files,
the copy exists as a duplicate of the original file. As long as neither the original file nor the copy is
modified, they remain duplicates, since the checksum of both objects is the same.

@ Tip: The files can be renamed, and still remain duplicates.

To Locate Duplicates in a Graphic Hub
1. Click View > Duplicates, or press CTRL + N, or CTRL + F5. The duplicates window is shown.

Duplicates on server 'VizDbServer@LOCALHOST — O

Selected Server

Server:  VizDbServer @LOCALHOST(Guest)

Duplicates
v [ MaGE ~
w11 4to-tower (3)
v [ Sto-tower (1/1)
B Ato-tower (data/Vizrt/Training/V5-203-D Viz-VS-Exam DesignWorkshop2(
B sto-tower (1/1)
B Sto-tower (2/1)
e B(2)
" bars_pentagons_light (2)
" Beijing-street-1(3)
" Black (2)
1 Breaking_News (3)
1 bubble(1) (4)
1 bubble_1(2)
1 ChrisBlack_Headshot (2)
1 ConcreteWornPaintd080_1_L (2)
“ rane (7Y e

Pause Close

Duplicates: 271 ...done!

The duplicates window lists all the duplicates in the selected server, sorted by the names of
the files. If duplicates carry different names, this is also shown.
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2. Right-click a duplicate for more information about it. This will open a menu with the
following options:
- Open Containing Folder in Explorer: Jumps to the folder in the Servers and Folders,

where the selected file is placed.
Properties: Opens the File Properties window, which shows detailed information about
the selected file.

2.5.7 Add Metadata

Graphic Hub supports keywords and add-ons that work like metadata, to help you to dynamically
organize your files better and enhance search capabilities.

Keywords
Up to 20 keywords can be assigned to any file, to enhance search capabilities.

- Select Tools > Administer Keywords to open the Administer Keywords window.

=Tk
[ Server ]
[Mzbbserver@aHSERVER Adn = [ Gt files containing the selected keyword(s) |
Keywiords: Filas containing the selscted keyword(s):
Keyword | o, of obi. | Hew Hame [ Type |
Mewe_Keyword_1 2 Imagel IMAGE
Mew_Keyword_2 2 Rename Image2 IMAGE
Refresh
_ S|
Riywords: 2 o

To View Files which Use a Selected Keyword

1. Open the Administer Keywords... window.

2. Click on a keyword(s).

3. Double click a keyword to view files assigned to it.

4. All files assigned with the selected keywords show in the right side panel.

To Create a Keyword
1. Open the Administer Keywords window.
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Administer keywords on server VieDbServer@GHSERVER' Amﬂ
[ Server
I VizDbhServer SOHSERVER (Admin) ;1 F I
Keywords: Files containing the selected keywerd(s):
Keyword [ Mo.ofoty.] | new || [name [ Type |
Mew_Keyword_1 2
Mew_Keyword_2 2 Renems |
]
Delete I
_Retuh_|
e |
Keywords: 2 o

3. Enter a name for the new keyword, and press ENTER.

To Delete a Keyword

A keyword can only be deleted if it is not assigned to a file or folder. Look in the No. of Obj. field
to verify how many files or folders the keyword(s) are assigned to.

a

are deleted.

Click the Delete button.

A WN—

To Assign a Keyword to a File

Note: If multiple keywords are selected, only the keywords with no assigned files or folders

Open the Administer keywords window.
In the left panel, click on the keyword(s) to delete.

Click Yes in the delete confirm window.

1. Right-click a file in the File panel and select Properties from the context menu.
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2. Click on Keywords in the Properties for <file name> window that opens.

x
(] Keywords
i Refersnces and links Mame: Imaged "ll
Duplicates
% s ey Type: IMAGE \VizZr t
le] Bdvanced uig: B2FTABE-FCCO-44CF-951 TACTENIISDCOF [ 1]
Bl History
EH Awvailabiity [ Show Al
B Add-Ons
Keymmeds: 1 Assignable keywonds:
Name ¢ [ | Name [
Mew_Keyword 2

3. Select/find a keyword(s) to assign to the file:
a. Enter a keyword name in the search box.
b. Click on Search, or Show All to see all available keywords

@ Tip: Wildcards such as * or ? are allowed in the keywords search string.

4. Click a keyword, in the Assignable keywords panel, to select it.
5. Click the < Add button.

& Note: Up to 20 keywords can be assigned to one file.

6. Click OK.

To Assign a Keyword with the File Context Menu

To assign a keyword(s) with the file context menu is better for on-the-fly keyword additions, but
does not show any other data about the keyword(s) which are assigned.

1. Right-click a file in the File panel to open the file context menu and select Add keywords...
Search for available keywords by entering the name of a specific keyword, or asterisk ( *)

to show all available keywords.

Select the required keyword(s).

Click Add...

Click Add in the Add keywords... window.
Click Close.

N

ounew
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To Remove a Keyword from a File

With this procedure a keyword(s) is first selected then the file(s). The advantage to that method is
greater visibility of information regarding each keyword and where it is used.

1.
2.

w

PN R

Open the Administer Keywords... window.

Click on a keyword(s) in the list of available keywords.

Double click a keyword to view the files assigned to the selected keyword. All files assigned
with the selected keyword(s) show in the right side panel.

Right-click on the file(s) from which the keyword is to be removed.

Click Remove keyword(s).

Click Remove.... in the Remove keywords from <file name>... window.

Click Remove in the Remove keywords... window.

Click Close.

To Remove a Keyword with the File Context Menu

To remove a keyword(s) with the file context menu is better for on-the-fly keyword removal, but
does not show any other data about the keyword(s) which are to be deleted.

1.

uTh WN

Right-click a file in the File panel to open the file context menu, and select Remove
Keywords...

Remove keywords from ‘Imaged’... x|

[ Mew_keyword_2 Seleck the
keywiords

khat should
be removed

Remove. ..

=

Select the keyword(s) to be removed.

Click Remove....

Click Remove in the Remove keywords... window
Click Close

Add-ons

Add-ons are a solution for creating templates to assign custom metadata to objects in the Graphic
Hub. This provides another dimension for searching, tagging and organizing objects. Add-ons
work similarly to Keywords, but are actually more extensible.

Simple Add-on Use Case and Conceptional Workflow

Images of people need to be tagged with the first name, last name, gender, and age.

1. Add-on template with corresponding fields is created and published. Only published add-ons

can be assigned to files.

2. The add-on is assigned to a file and the values wanted are entered.
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3. Afterwards, the search grants the ability to view this information, for example, all files with a
specific add-on or gender male assigned are retrieved.

@ Tip: Add-ons assigned to files are exportable and importable through Archives and are
deployed with Graphic Hub Manager and the Deploy Agent.

A typical add-on assigned on a specific file could look like:

- Add-On: Vizrt Meta Data

- Title: My Metadata Element 01

- Alternative title: Add-on Example 01

- Synopsis: Add-on use case
Rights: Rights reserved and held by creator and contributors
Date: 20-02-2018
Language Code: ENGLISH
Media Type: Production Element

- Creators: various

Add-ons are administered from the Add-ons window. They are assigned from the Add-ons Panel.
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Add-ons 'VizDb5erver@GHSERVER'

1\wzrt‘1l
1]

Imaged

1 object | O selected

Marme: Imaged

Type:  IMAGE -,\'u‘lzrt\
ULID:  62F7AS4E-FCCO-4ACF-9A174C7E0335DC0F 5

T Text | @ ede | @ o |

Search: I On | Up |

[ Match case [ Match whole word

Each add-on can have several entries. Entries can be numbers, strings, UUID, date and XML (for use
by external applications). Each entry also has a Proposal, which sets out the options for the add-on
in an eventual drop down box. You can also add informational text for a tool tip, which is shown
when you mouse over the region of its name in the add-ons window.

One use case for add-ons is approval states. You can create an add-on with the parameters of
Draft, Pending, and Approved. If an art director does not want any scene on the design cluster to
be make it to the playout engine, they can use the Import External Images functionality to take all
new scenes, assign the add-on, and then only deploy scenes that he has personally approved to
the playout engine.

To Create a New Add-on

1. Open the Graphic Hub Manager
2. Open the Administer add-ons window:
Click Tools > Administer add-ons..., or
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Press CTRL + SHIFT + F8.
3. Open the Create add-on window:

From the Administer add-ons window, click the Create new add-on... button E] , or
right-click in the Add-ons quadrant and select Create new add-on...

x
Mame: ||
Eroup: I{wmuped:b j
[T allows transfer via DDC ™ Allow transFer via archive export/import
Mame | Data type | Defailt | Mandatory? | Tockip | Restricked? |
Info:
)4 Cancel
4

4. In the Name field, enter a name for the add-on.
5. From the Group drop down box, select from:
ungrouped: The new add-on is not in a group.
- <group name>: Select a group to put the new add-on.
6. Check the Allow transfer via DDC, if required (when checked, the add-on is transferred
through DDC (Direct Deploy Copy)).
7. Check the Allow transfer via archive export/import, if required (when checked, the add-on
may be transferred via Archives (exported/imported)).
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8. Click the Add... button. The Create entry of add-on window is shown.

11.

12.

13.

14.

15.

x
Marmne: I |
Data bvpe: IString j [ Mandatory
Proposals; Imanual j
Add | |
Remoye = |
Up I Top I
™ Restrict D, | Bat.
Cefault value: | <none:= j
InFo:
(84 Cancel
A

In the Name field, enter a name for the add-on entry.

. From the Data Type drop down box, select one of the following options:

Number: Only manual proposals supported.
String: Supports manual proposals and having all registered users as a proposal
option.
Date: No proposals supported, namely selecting a date from a calendar.
UUID: No proposals supported.
XML: No proposals supported.
Check the Mandatory check box for it to be mandatory for this entry to have a value.

Uncheck it for the entry to be optional.
From Proposal drop down box, make sure Manual is selected.

A Note: If the Data Type is String, the option of selecting <all users> as the Proposal is
available. In this case, no further Proposal configuration is required.

In the Add field, enter an option that is available for selection and click the Add button.
Repeat for as many options as you want to have in your proposal. You can also remove
options by clicking the Remove button, as well as changing the order in which options
appear by clicking the Up, Down, Top and Bottom buttons.
Check the Restrict check box to restrict the proposal entries to what you have added above.
Uncheck it to allow user-defined entries in addition to your proposal options.
From the Default value drop down box, select one of the following options:
<none>: There is no default value assigned. Not available if the entry is restricted.
<user defined>: The value is defined when assigning the add-on. Not available if the

entry is restricted.
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- <current user>: The logged-in user is the default value. The other proposal values are
also available.

- <current time>: The current date and time are the default value. Only valid if the Data
Type is Date.
Any of the other proposals you have defined above.

16. In the Info field, enter any text that you wish to appear as a tool tip when mousing over the
add-on once it has been published.

© Caution: Any text you enter in this field is exposed to end users.

17. Click OK.

To Create an Add-on Group

1. Open the Graphic Hub Manager.
2. Open the Administer add-ons window:

- Click Tools > Administer add-ons...
3. Open the Create add-on group window:

In the Administer add-ons window click the Create new add-on group... button , or
right-click in the Add-ons quadrant and select Create new add-on group...

Create add-on group ) x|

Marmne: I |

ik | Cancel |
4

4. In the Name field, enter a name for the add-on group
& Note: Make sure that the new Group name is unique.
5. Click the OK button. The new Add-on group shows in the Add-ons quadrant.

& Note: Add-ons can be dragged from group to group as required.

To Publish an Add-on

© IMPORTANT! Add-ons are automatically saved during the creation process and can be
modified as required. But the Add-on cannot be assigned until it has been published. As
long as the Add-on is assigned to any file on the server, it cannot be deleted. If the Add-on
is not (no longer) assigned to any file on the server, it can be deleted.

1. In the Add-ons quadrant of the Add-ons window, right-click the add-on and select Publish
add-on. You are queried if you are sure you want to publish this add-on.
2. If the add-on is ready for use, click Yes.
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To Filter Add-ons by Type

In the Add-ons quadrant of the Add-ons window, from the Filter by type drop down box,
select one of the following options:

- All: All add-ons.

- User-defined: All add-ons created by any users.

- Viz: External metadata created by another Viz application.

- System: All Graphic Hub server-delivered add-ons.

To Filter Add-ons by Stage

In the Add-ons quadrant of the Add-ons window, from the Filter by stage drop down box,
select one of the following options:
- All: All add-ons.
Draft: Unpublished add-ons.
Published: Published add-ons.
Retired: Add-ons retired from active use (because they can be withdrawn from service
but not deleted from the system).
Imported: Metadata exported to Graphic Hub by other Viz applications.
- Copied: Transferred in a deploy operation.
From archive: Add-ons exported by Viz Engine and re-imported from a Viz Artist
archive to the Graphic Hub.

To Sort Add-ons and Add-on Groups

1. Click Tools > Administer add-ons... to open the Administer add-ons window.
2. In the Add-ons panel, select on an Add-on or an Add-on Group.
3. Drag the Add-on or an Add-on Group to its new location.

To Assign an Add-on

1. Enable the Add-ons Panel.
2. Select one or more files and drag them into the add-ons header. To remove a file from the
add-ons header, click it and press Delete.
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3. Click the Edit tab.
Add-ons available for assignment are shown.

Add-Ons
M ame: |maged \
Type: IMAGE -k'u‘izrli
ID: B2F 7A84E -FCCO-4ACF-341 7ACTEDZ350 COF Ei
B 1o @ Edi | |
;l “Ungrouped =
;l ¥ status
Currenk_Skakus: I Approved j il ﬂ
Modified by: I Adriniskrator j i ﬂ
Modified at: I 9 gf2016 9:12:49 4M j i
;l ¥ Information
Person_Mame: I Administrator £ ﬂ
[ Lock editing Discard | apply |

4. Click the button to the left of an add-on to expand it.
5. Check the check box beside the add-on to select it.
6. Do one of the following:
Select a value from the proposals drop down box.
Enter a value in the field (allowed only if the add-on is unrestricted).
Click the E button to the right of the add-on to edit the proposals (allowed only if the
add-on is unrestricted).
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Select a date (allowed only if the add-on is for the Date data type).
Add-ons 'VizDb5erver@GHSERVER'

Image_1 Image_2

2 objects | 2 selected

Marme:

Twpe:
LT

B Tex ® Edt | |

;l “Ungrouped =

J ¥ status
Current_Status: I <mixed values! = - *ﬂ
Modified by I <mixed valugs! = j i ﬂ
Modified at: r 9/12j2016 11:14:18 &M |®]*
ﬂ ™ Information

A Note: With multiple files selected, where some have add-ons with different
values, the entries that have different values displays <mixed values!>.

7. Click Apply.

To Retire an Add-on

1. In the Add-ons quadrant of the Add-ons window, right-click the add-on and select Retire add-
on. You are queried if you are sure you want to publish this add-on.
2. If the add-on is ready for use, click Yes. The add-on is no longer available for use.

2.5.8 Replace File References

By replacing references it is possible to replace, for example, Images or Fonts referenced by
Scenes or Geometries, with different Images or Fonts. It is only possible to replace an Image with
an Image, or a Font with a Font.

To replace references is practical, for example, when rebranding a corporate identity.

© Caution: Do not replace references at random. Make sure that the replacement files are
compatible in terms of size, scale, color, and other Viz Artist properties used for playout.
Research and test before replacing references.
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© Caution: Use the replace file references feature with care, as it can potentially be harmful.
For example, if the image to be replaced is in a Scene which is currently on-air.

© Warning: There is no UNDO to this procedure. Be very careful, and try this procedure first
on one or two Scenes only.

& Note: References in one file must be unique. It is not possible to replace multiple
references with the same file (UUID). If multiple references (e.g. fonts) need to be replaced
with the same file then this needs to be done in Viz Artist.

To Replace References

1. In the Graphic Hub Manger, right-click the required file or files and select Replace
References...
The Replace References wizard opens.

Replace references wizard 1 = ﬂ

Wwelzome to the wizard that will quide you through the process of replacing an object in the
objects you have selected.

— Owveriew — Filter

Summarization of your selection. Select belaw the type of object you

Depending on vour previous zeleckion, it iz want to replace in the objects dizplayed

poszible that not all objects are dizplaped here. in the overview on the left:

E.g. objects that may not contain references [as

imagesz] are not dizplayed here. I,-’.'-.LL j

= TOTAL (1) Specifiy below if on the following page
= SCEME 1] of the wizard pou want to only see
Sample_Scene objecs that are referenced by all the

ohjects dizplaved in the avervigw an
the left;
T Commen

< Back I MHext = I Cancel

2. Optional: In the Filter panel select which type of object to replace from the drop down box.
Options are:
All

Image
Font
Geometry
Audio
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3. Click Next.
| voGrMensger alo
Server Vew Took Edva Pt Infa
G [ Addenss | 15 dakn\Prejectl | Types |4dL IH i iu-:hn i ; E{ Laye
[ Servers anatians - o x i I ¢ |owtewodfied | Hodfedty | Duteoe
0% Servess anea falders 1 ), Search —xxf rﬂderﬁ ::‘-:'f:::
. ._‘.'_":"ﬁ““'wmm W image 19608 INAE FTIZO0E BI2ALPH Adwin ST
E l'- K imagesi1) EAITOR  [MAGE R0 15, Adein LT 1T
T I Eimage2 209MD  IMAGE ST B0 PM  Admin ST
& SubPvopti [ ¢ [EEEC SRFTRE  IMACE STS00E D0 P Adeir TR
& b Eiimaget ZIEME MAGE TS BILAOPM  Aden SRR
s Fuidkerl
& FokderZ
| Replce rdmences wizard2 2
Eolon ey £ pristeet] pias rawes bures s e e an Lipset] i,
Hhhlhumuﬂhmmmwuﬂwnﬂdmm-
spbpoprc ir the izt
Hioter poas may orily drog 8 obyect ondo s esfenerce in B ki with the Lame hipe.
“Yoas sty oy 0 B Obeedt Fere Bt i bzaled on th same pereet
 Rieplace |y [Tpe | Aeleerce
TE] - Yo TRk
000l _ w265 - LT
56 Feiiad Irnaged BaAGE !
b - MAGE /1
cha_eyve_peechsla_im — REAGE -
(harews 222222 . meAGE ek ad b
wection,_simpls - mealil Trirged!
iechion,_sepie] BRAGE
Ay 15 - LTETE S %
e st - BaAGE -,I.'u'lzrt
Ho_0N 28 armieds . BAAGE 1)
loga_ctud - maalE
Paftboe_2 - mAGE
repds_prrnanes . BAAGE
wa_ bl S8 - meall
#ial_canpagrebiu] BEAGE
STARS - mRAGE
uslagl - BeAE
< Bask Frich Carcel |
1] I X
7 objects [ foksry, 5 18er)

4. Drag replacement files onto the listed files of the same type

5. Click Finish. The Action Log for replacing references is shown.
6. Click Replace.

2.5.9 Direct Deploy Copy
The Direct Deploy Copy (DDC) function deploys one or more folders/projects/files:

Multi Server Deploy: Deploys one or more folders/projects/files in exactly the same folder
structure to two or more selected servers.

Server to Server Deploy: Deploys one or more folders/projects/files to another server using
one of three methods:

Rebuild the original structure.
Copy the folders/projects/files to the target folder.
Rebuild the structure under the target folder.

For Multi server deploy, rebuilding the original structure is the only available method.

Direct Deploy Copy (DDC) tasks can also be scheduled and run, as and when required (see Graphic
Hub Deploy Agent).
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Multi Server Deploy

Multi Server Deploy deploys one or more folders/projects/files in exactly the same folder structure
to two or more selected servers.

To Replicate on Multiple Servers

1. In Graphic Hub Manager, log on to two or more servers.
2. Right-click a folder, project, or file, in the Servers and Folders or Files panel, and

select Deploy.

Copyright © 2023 Vizrt Page 91



Graphic Hub Administrator Guide - 3.8

The Deploy Direct Copy window opens and the analysis process begins.

Bt Deploy Direct Copy - Options for multi-server deploy — O >

servers to deploy to {chedk the ones you wish to deploy to)

Id MName Type Free disk space

1 VizDbServer@GHSERVER. Standard 14.84 GB

2 GHMainServer @GH-MAIN Standard 14.99 GB
Top Up Daown Eottom

Preparation progress [ info

Infos, warnings & errors

Retrieving folder contents from the source server: Finished

Behavior options
Rebuild original structure

Cwerwrite existing objects (Does not apply to referenced objects)

Cwerwrite existing references |:| Cverwrite creation date
Chwerwrite owner [ ] overwrite modification date
Multi-server processing options

(®) Deploy all files to the first server, then to the second, and so on

() Deploy one file to all servers, then another file, and so on

Auto continue (Deploy will automatically start after preparation step) Cancel

3. In the list, select the target servers where the folders/projects/files should be deployed.

@ Tip: The servers can be sorted by clicking the Top, Up, Down, or Bottom buttons.
This increases/decreases the priority level of a specific server.

4. Enable/disable the following options:
- Overwrite existing objects (does not apply to referenced files).
Overwrite existing references.
Overwrite owner.
Overwrite creation date.
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Overwrite modification date.

5. Select one of the following processing options:
Deploy all files to the first target server, then the next server in the queue, and so on.
Deploy one file to all target servers, then the next file in the queue, and so on.

@ Tip: You can predefine the options in Steps 4 and 5 by clicking Tools > Edit
Preferences > Deploy Direct Copy . Once defined, these preferences are set as
defaults for every deploy operation you configure. Note, however, that Rebuild
original structure cannot be redefined for Multi server deploy.

6. Click the Continue button.
The Action Log for deploying files is activated.

#t+ Deploy Direct Copy... (from 'VizDbServer@Z420-CW0D') — O x
File Fram To
.. Image_4 data/Folder 1 VizDbServer @GHSERVER: ...
.. Image_3 data/Folder 1 VizDbServer @GHSERVER: ...
.. Image_2 data/Folder 1 VizDbServer @GHSERVER: ...
wns IMmage_1 data/Folder1 VizDbServer @GHSERVER.: ...
.. Image_4 data Folder 1 GHMainServer @GH-MAIN: ...
s Image_3 dataFolder 1 GHMainServer @GH-MAIN: ...
s IMmage_2 data/Folder 1 GHMainServer @GH-MAIN: ...
.. Image_1 data/Folder 1 GHMainServer @GH-MAIN: ...
€ >
[] cloze this window automatically if no problems occurred Deplay Cancel
Reuse this window for same actions
[ ] Do not insert entries that are already in the list Warn me about not inserted
2 entries to be processed.

7. Click Deploy. The folders/projects/files are then deployed. When the deploy process is
finished, check the Action Log for possible errors, and if necessary, attempt to redeploy any
unsuccessful files.

Server to Server Deploy

Server to Server Deploy deploys one or more folders, projects, and files, to another server using
one of three methods:

Rebuild the original structure.
Copy the folders/projects/files to the target folder.
Rebuild the structure under the target folder.

To Replicate on One Target Server

1. In Graphic Hub Manager, log in to two servers.

Copyright © 2023 Vizrt Page 93



Graphic Hub Administrator Guide - 3.8

2. In the Explorer panel, select source files/folders/files, and then drag them to the target
folder in the required server.

@ Tip: For single folder or project deployment, the Servers and Folders panel can also
be used.
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Server View Tools Extra Pilot  Info

£E Address: 1:Mdata\Project2\Folderd

Servers and folders 3 X8 Mame ~
IU?: Servers and folders Image_l
v il 1-VizDbServer @GHSERVER (Admin) B Image_2
v w data Biimage_3
“ @ Projectl Image_4
- SubFaolder1
.. SubFaolder2
* W Project2
| | Folderi
... Folder2
~ [ 2 - GHMainServer @GH-MAIN{Admin)
e dats
Folder1
ol ]

The Deploy Direct Copy window opens and the analysis process begins.
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3% Deploy Direct Copy - Analysis & Options - O >
Summary
Destination path: GHMainServer @GH-MAIN: fdata
Available disk space on server 'GHMainServer @GH-MAIM': 1493 GE
Selected objects: 5 47.82KB 47.82 KB
Referenced objects: 0 0.00 KB 0.00 KB
All objects: = 47.82KB 47.82 KB

Analysis

B Image_<4 (IMAGE - 10.70 KE)
1 Image_3 (IMAGE - 15.39 KB)
B Image_2 (IMAGE - 13.64KE)
B Image_1 (IMAGE - 8. 10 KE)

Infos, warnings & errors

Info: Analysis finished without any warnings or erraors!

Step § - Analyzing objects on the taroet server: 4of 4

Behavior options

Rebuild original structure -
Cwverwrite existing objects (Does not apply to referenced objects)
Cverwrite existing references |:| Cwverwrite creation date
Cverwrite owner [] overwrite modification date

3. Select one of these options:
Rebuild Original Structure: Copies an exact replicate of all selected folders/projects/
files and its references from source to destination server.
Copy to Target Folder Only: Copies all selected folders/projects/files and its
references from the source server to the destination folder on the destination server.
Rebuild structure under target folder: Copies an exact replicate of all selected folders/
projects/files and its references from the source server to the destination folder on
the destination server.
4. Enable/disable these options:
- Overwrite existing objects (does not apply to referenced files).
Overwrite existing references.
Overwrite owner.
Overwrite creation date.
Overwrite modification date.
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@ Tip: You can predefine the options in Steps 3 and 4 by clicking Tools > Edit
Preferences > Deploy Direct Copy . Once defined, these preferences are set as
defaults for every deploy operation you configure.

5. Click the Continue button. The Action Log for deploying files is activated.

3+ Deploy Direct Copy... (from 'VizDbServer@Z420-CW0O'") — O ot
File From To
ves IMage_4 data/Folder 1 VizDbServer @GHSERVER: ...
.. Image_3 data/Folder 1 VizDbServer @GHSERVER: ...
wes IMage_2 data/Folder 1 VizDbServer @GHSERVER: ...
.. Image_1 data/Folder 1 VizDbServer @GHSERVER: ...
s IMage_4 data/Folder 1 GHMainServer @GH-MAINM: ...
ves IMage_3 data Folder 1 GHMainServer @GH-MAIN: ...
.. Image_2 data/Folder 1 GHMainServer @GH-MAIN: ...
. Image_1 data/Folder 1 GHMainServer @GH-MAIN: ...
£ >
[ ] Close this window automatically if no problems occurred Cancel
Reuse this window for same actions
[ ] Do not insert entries that are already in the list Warn me about not inserted
8 entries to be processed.

6. Click Deploy. The folders/projects/files are then deployed.
7. When the deploy process is finished, check the Action Log for possible errors, and if
necessary, attempt to redeploy any unsuccessful files.

2.5.10 Graphic Hub Search

The Graphic Hub Manager’s search functions can search for files, folders, and projects, on one or
more servers.

Copyright © 2023 Vizrt Page 97



Graphic Hub Administrator Guide - 3.8

AL ol
Server Wiew Took Exbes Plot  Iofo
Addres  bodata'Falderd = O i types [ann - 4 G Seandui f Lo
| Search Soa | Tpe ! Lratr st et celfwd By | D
(Ve Semvers and falders ) ), Searcn Image 195 ME  IMAGE AAIE086 11303 Addrrar )
B Himage_1 TATMD IMAGE SPAE006 LiFHOIFH  Admn o
[rrescest =] T e LI8MB IMAGE STIE00E LIOAEM  Admn o
I 5 Iy
o [Arr e 3 | Blimage_t 2OGME IMAGE A6 L0 PH  Adwn o)
hers: IEWW{Wnﬂsmmwﬂ
=] § .
e J »
Mt Impe | | 1
B vettcerangaERER San
GtanteraBOHHAN et [T T I——
o ik ha I Sarpie_Scene AELETER SCENE
s 140,368 MAGE
Bl imaged LM AGE
. | B bbogelreguin S BOKE  BASE_FONT
s SubFoier2 Fbier
I Saarch in spescifisd folder #| T e Reficold TLOSKD BMAGE
A [ bl agt | Friswit -
™ Saspdh by sdvancsd proparties. *| i "
r oot e | 51 objects (5 projects, 4 Fokders, 42 fites)
e

There are two primary types of searches available in the Graphic Hub Manager: Free text search
(which includes a Quick search), and Standard search. In addition, it is possible to search for files
in the available databases by universally unique identifiers (UUIDs).

If the search panel is not open, enable it under View > Panels > Search. Search results are shown in
the Results panel and results can be filtered per server, if the search included more than one
server.

Free Text Search

The free text search searches for files, folders or projects and can include any or all of these
search strings:

File names

Folder names

File owners

File UUID (on Graphic Hub version 2.3.2 and higher)
File type (geometry, font, images, etc.)

Assigned keywords

Created time

Modified time

Add-ons (metadata)
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To Search Using Free Text Search

1.

In the Search panel, select Freetext in the Name / Freetext drop-down list:
Search v 0 X

D‘ESEmers and folders 'x:', Search
A /(L searen’y

IFreetex't: vI b ik

T

Freetext:
| Any type |

Where: IEverywhere (objects and add-ons) j
IF'_:_'-_:-- Ch ON Checken Servers only —F
Mame | Type |
VizDbServer @GHSERVER Standard
D GHMainServer @GH-MAIM Main

l I

I|_ Search in spedified folder

[ Search by advanced properties
L

I~ Search b selected kevivords

I~ Search b referenced referencing files
L

1l e e le (=

™ Searchin add-ons (metadata)

the Search string syntax.

The type field can be used to include or exclude one or more of the following types:
- Any type- the default mode, all elements are included.
- AUDIO_CLIP
BASE_FONT
FONT
- FONT FACE and FONT Files (for Viz Engine 4.x and higher)
- GEOM
IMAGE
MATERIAL
MATERIAL_ADVANCED
- MATERIAL_DEFINITION (for Viz Engine 4.x and higher)
- SCENE
- SHARED_MEMORY_MAP
- SUBSTANCE
VIDEO_CLIP

. Enter the search parameters in the Freetext field. To achieve the best search results, refer to

. The Type drop-down list is used to narrow the search to a specified set of file types only.

Right clicking the type excludes it from the search, identified by a dimmed check mark. For
example, here the BASE_FONT type is explicitly excluded, while the FONT type is included in
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the search:
’ IBASE_FOMT, FONT j
wehere! I~ Any bype
[T auDIO_CLIP
I Search on g [7 gase_FonT
[Jarne
; [T GECM
YizDb5e
M [T macE
[ MATERIAL
r MATERIAL_ADVAMNCED
™ scemE
[T SHARED_MEMORY _MaP
1] [~ SUBSTANCE
[T vIDESD CLIP
[~ Searchin specified Folder +
L
[~ Search by advanced properties il
L
™ <Search by selected keywaords il

. Select where to search in the Where drop-down list:
Everywhere (objects and Add-ons)
In objects (files and folders only)

In add-ons (metadata only)
. If the GH Manager is logged on to more than one server, the Search on checked servers only
box can be used to specify which server(s) the search is performed on. If checked, at least
one server needs to be selected for the search to run.
. If the GH Manager is logged on to only one server, or if multiple servers are logged on to
and only one is selected in Search on checked servers only, the folder which is to be
searched can be specified as required:

a. Check the Search in specified folder check box.

b. Select the folder to be searched.

¢. Check the Search in Sub-folders check box to run a recursive search.
. To search by last modified date or date of creation, check the Search by advanced properties
check box. The search by date approach can be narrowed further by specifying from date,
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until date, and between dates:

IV search by advanced properties —|_
Size (i KB Ian-r' size j I o
Created: between j I gf 72016

anytime I 9/ 7/2016
from
Modified: until I 9f 7f2018
Expiration: [/ /2016

[T Use aroups inst, of users

Caned by Ian'-r'l:une

fodified by Ian'-r'l:une

Checkediout by Ian-r'cune

Search by access-riahts

™ Search b selected keviwords

I Search b referenced referencing files
L

N 3 1 4 B3 3

™ Searchin add-ons (metadata)

8. Press ENTER or click on the search icon “* to run the search.

& Note: Click on the icon to expand or collapse the search criteria selection for
each category.

Search using all available search criteria can only be performed on one server at a time.

Quick Search

The Quick Search function gives a quick means to search for a file, folder or project.

To View the Quick Search Bar

1. In the main tool bar click on View > Toolbars > Quick search .
2. Click on Quick search to open or close the Quick search toolbar.

To Use the Quick Search Function

1. In the Quick search tool bar click in the Servers drop down list and select the server or all
servers to be searched.
2. In the text field enter the search string.

3. Press ENTER or click on the search icon .
Search in: IAII Servers j = LLe

Deploy Search Results

The Freetext search results can be used to create a deploy task. This can be useful for creating
deploy tasks for daily additions or modifications, for example.
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f—

. Perform a Free text search.

2. In the search results, select the result that matches the requirements for the deploy task and
press CTRL + D, or right click and select Deploy.
3. Proceed to Create a New File Based Deploy Task.

Standard Search

The Standard search searches for files with more detailed search options. Search by one or a
combination of different search criteria.

To Search with Standard Search

1. In the Search panel, select Name in the Name / Freetext field.

Search v 0 X
/U‘E'g Servers and fnlders}”x‘-'., Search\

IFreete:d:: vI i et

Freetext:
| Any type =l

Where: IEverywherE (objects and add-ons) j

2. In the Name field enter name search parameters, if required.
From the Type drop down box, select the file type to be searched for.
4. Click on the check boxes to add search criteria as required.

w

& Note: If more than one server is open or selected, only the Advanced Properties
criteria is available.

- To Search by Specified Folder

- To Search by Advanced Properties
- To Search by Selected Keywords

- To Search by References

5. Press ENTER or click on the search icon .

& Note: To open or hide search criteria, click on the +) icon to the right of each search
criteria.

If Search on checked servers only is checked, at least one server must be selected.

To Search By Specified Folder

Check the Search in specified folder check box.
Select a folder to search in.

If required, check the Search in subfolders check box.
If required, add more search criteria.

Press ENTER or click on the search icon “* to search.

v hWN —

To Search By Advanced Properties

1. Check the Search by Advanced Properties check box.
2. Enter search parameters as required:
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- Size: Searches for files that are either at least, at most, or between the defined size(s)
in KB.

- Created: Searches for files created either after, before, or between the defined date(s).
Modified: Searches for files modified either after, before, or between the defined
date(s).

Expiration: Search for files expired either after, before, or between the defined date(s).

- Use group instead of users: If selected, the next four options apply to groups instead
of users.

A Note: Only registered users/groups are available from the lists.

- Owned by: Searches for files owned by user.
Modified by: Searches for files that was last modified by the defined user.
- Checked out by: Searches for files checked out by the defined user.
- Search by access rights: If selected, searches for files that have write permission either
on user (UW), group (GW), or world (WW) level.
If required, add more search criteria.

Press ENTER or click on the search icon % to search.

To Search By Selected Keywords

1.
2.

Check the Search by selected keywords check box.
In the upper field enter the first characters of the keyword, or enter *** to list all available
keywords.

3. Alist of available keywords that match the characters then shows in the keywords list.
4.
5. Check or uncheck the All checkbox:

Select one or more keywords that match the search criteria.

- Checked: Search for Scenes or Geometries which contain all search files.
Not checked: Search for Scenes and Geometries which contain at least one of the
search files.
If required, add more search criteria.

Press ENTER or click on the magnifying glass “* to search.
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To Search By References

. Check the Search by Referenced/Referencmg Files check box.
¥ :lth:lrLI [} Ll':." [=E=] =] ILb‘LI,lrb‘I BTSN | Ilb'b- | o
Info |
Drrag files From Explorer-Details ar From
Search-Result and drop them here!

Iv &l ¥ Referenced Remove all I

2. Drag and drop a file or files into the drop area.

| veerMansger =10l x]

Server View Todks Extra Plot Info

::{‘... Addressc  1odstaProjedl & IJ--_:: I'nu ALL : Sean ! ‘ Layo

[ | Herre Size | Typs | Diste masciec

05 Servers and folders | L, Search "wdﬂﬂf Pokder

[Hame: =] T s Eimeges 1.96M0 IMAGE 712016 3:3:
3 2| Eimege(l) E327EB  IMAGE RI2016 12

Lot {0 tyoe X B images 2038 IMAGE e e

T [2006 4:0n

=] 1 | |

[7 eibpects 12 foldens, 5 files) |1 obpect selected

3. Make sure that the Reference check box is checked.
4. Check or uncheck the All check box:
Checked: Search for Scenes or Geometries which contain all search files.

Not checked: Search for Scenes and Geometries which contain at least one of the
search files.
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5. If required, add more search criteria.
6. Press ENTER or click on the search icon “* to search.

@ Tip: Use Search by References to search and replace Images or Fonts referenced by
several Scenes or Geometries, with different Images or Fonts. For example, if a
company logo changes, search for the image references, select each required Scene
and replace the image (see Replace File References).

Search by UUID

The Graphic Hub keeps track of all items in the database by assigning Universally Unique
Identifiers (UUIDs). This also applies to deployed items, which means that if an item is deployed
from one server to another, it has the same UUID on both servers. When the UUID of an item is
known, it can be looked up very quickly using the Search UUID on server.

To Search by UUID on Server

1. Open Graphic Hub Manager, and log on to the server(s) that is to be searched.

2. From the Tools menu, select Search by UUID.... This opens the Search by UUID on server
window.

-ﬁI— Search by UUID on server "Main@TUTORIAL X

Server

Main@TUTORIAL (Admir) Cancel

Enter the UUID of an item in the following format

where each ¥ must be '0-9' or 'AF" (or 'a-f):

| Properties...

3. If you have logged on to more than one server, select the server to perform the search on in
the Server drop-down list.
4. Enter the UUID in the editable text field. This text field accepts valid alphanumeric

characters only. Valid input are digits in the range 0-9, and letters in the range A-F . The
search is not case sensitive, and dashes are added automatically:
-ﬁI— Search by UUID on server "Main@TUTORIAL >

Server

Main @TUTORIAL (Admin) Cancel

Enter the UUID of an item in the following format

where each ¥ must be '0-9' or 'AF" (or 'a-):

8201af90-8d10-4633-8437-9e7412c3f320

5. Click Properties... to perform the search.
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If an item with the provided UUID is found, its Properties page opens.
If no item on the database matches the provided UUID, you are alerted by a popup
window.

Search String Syntax

Free text search string syntax is very similar to the search string syntax of other comparable web
search engines.

Example 1: zebra scene -project -folder

In example 1, the search is conducted on any file names, file owners, UUIDs, file types, and
keywords that include the string zebra and scene . This search excludes projects and folders,

plus any of the other searched files that include the words project and folder .

Example 2: giraffe -image -geometry
In example 2, the search is conducted on any file names, file owners, UUIDs, file types and
keywords that include the string giraffe . This search excludes images and geometries, plus any

of the other searched files that include the words image and geometry .

Wildcard Text Description
If the full Name is not known then text Wildcards can be used to make a search:

% : Match any characters. For example: Element
? : Match any single character. For example: E1?me?t
[ 1 : Match a range or a list of characters. For example:
Elem[b-g]nt
Elem[shje]nt
< > or{} Match a specific project, folder or file:
Searching for a specific UUID, for example <6E6D3467-0A37-4D35-
B80683B3A929772D> or { 6E6D3467-0A37-4D35-B80683B3A929772D }, returns the

specific UUID.
Searching for a partial UUID, for example <6E6D , also includes the underlying UUID.

Best Practices for Searches

The Graphic Hub Manager search capabilities are powerful enough to replace the need to browse
for files in the server tree. This is meant to make your Graphic Hub work faster and easier.
Example 1: If a Scene has been created on the design cluster, and saved as soccer, search for
scene soccer. From the search results, drag the scene to deploy it to a Graphic Hub for the Viz
Engine.

Example 2: Use the search feature to clean up a server. If the tree structure is complex, it can be

cumbersome to find all the correct scenes. In this case, create a new and elegant tree structure
and then find all the scenes in the old tree structure with a search by date and size. In this way,
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the new structure can be populated with relevant objects, in a logical order, and files that are too
old or too large, etc., can be removed.

To Export Search Results
To export or copy search results for external use one can:

Copy (CTRL + C) from explorer view (files and folder/projects) and search results (explorer
and archive search) to the clipboard to be able to paste it to external applications (for
example, Excel).

@ Information: The Copy/Paste option is only available on a certain server, not not on
the "All Servers Tab"

Export CSV search result (explorer and archive search) by right clicking into search result
view and selecting Export search result... and selecting the location where the .csv file
should be written to.

Name (3) wmn

KfLicht Blue £263C 11B-52CE-CD42
B 10000_variz Show as icons. 3F35-653A-9947-
Ko 05342834 -004D-
B0 b Link (Create shortcut), QY L e 0aan
B oradient_bi Duplicate (Copy)... Ctrl+ C \00458-8560-42C6-
[Eibue refiect A 116 8E75-460A-
Eibgblue i Ctrl+D  laog7a 73819535,
Kvariue Create deploy task 46AAF-B442-8A44-

n Setowner.

Set access..

L

Set expiration date...
Set creation/modification date...

Re-save with viz...

@

Add keywords...
Remove keywords..

-]

Replace references..
Compress images...
Check out...
Checkin...

Lock...
Unlock..

0 23 A

Delete... Del
Veify/restore...

Open in explorer

Bfiles Export search result... ject selected

Properties...

2.5.11 Server Information

This page details the different methods to monitor a sever and its details.

Terminals Monitor
Active Sessions
Monitor Servers
Server Properties
Chat with Artists
Object Types
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Terminals Monitor

The Terminals monitor window provides an interface to view all on line terminals within the
network. A terminal is the physical machine where the Graphic Hub Terminal application is
running.

Terminals
Available Viz GH Terminals (servers and naming services): Show single-user servers on other computers
Terminal Server info Mamingservice info Connection Server
0 ZB20-TEST123 VizDbServer @Z820-TEST123: 19396 Z820-TEST123:19396 Connected! VizDbServer
< >
1 Wiz GH Terminal (found by using UDP-port 19394 with a broadcast receive timeout of 0,50 seconds)
Refresh Login... Start server | | Start namings. Advanced options...

To Open the Terminals Window

Click Server > Terminals. The following columns are available:
Terminal: Shows the hostname of the physical machine where the Naming Service and/or
server are installed. An icon represents the status of the server and Naming Service:

& Both the Naming Service and server are down.

L The Naming Service is running, but the server is down.

= The Naming Service is down, but the server is running.

Both the Naming Service and server are running.

Server info: Shows <Graphic Hub Server>@<Graphic Hub Naming Service>:<port the naming
service is listening to>. A plus sign is added if you are logged on to the displayed server.
Naming Service info: Shows <Graphic Hub Naming Service>:<port the naming service is
listening to>.
Connection: Shows if Graphic Hub Manager has a valid connection to the Graphic Hub
Terminal.
Server: Shows the name of the server.
S. host: Shows the hosthame of the physical machine where the server is installed.
S. port: Shows the port number the server communicates through.
S. up: Shows if the server is running. This is also indicated by the icon in the Terminal
column.
S. in: Shows if you are logged into this server.
Naming Service: Shows the name of the Naming Service.
Ns. port: Shows the port number the Naming Service communicates through.
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Ns. up: Shows if the Naming Service is running. This is also indicated by the icon in the
Terminal column.

- T. TCP-port: Shows the TCP port number, which can be used to start the server remotely
from Graphic Hub Manager.

- Terminal host network IP: Shows the IP address of the Terminal machine.

The following additional options are available:

Show single user servers on other computers: If selected, also shows servers/naming
services in the network that are running in single-user mode (localhost).
- Advanced options: Open the Terminals Advanced Options window. Alternatively, press ALT +
A.

UDP-Port: Set the UDP port where Graphic Hub Manager searches for Terminals

(default: 19394).

& Note: The terminals window can only be used with pre-web-based Graphic Hub
Terminal (version 2.4.2 or older). The UDP port must be the same as the port
that the Graphic Hub Terminal listens to. To check the port number, go to the
Graphic Hub Terminal and check in Naming Service, which UDP port is set.

- Timeout: Define how long the Graphic Hub Manager should listen for Terminals before
timing out. The value is set in milliseconds.

Terminals - Advanced options

IDP port (for finding available Viz GH Terminals):
Timeout (jn miliseconds):

0 Cancel

- =
o | | [
S| | I
]

[ ¥}
m
(]
m
+
|
i

Refresh: Updates the list. Alternatively, press ALT + R.
Login: To log in to a server, select the required server from the list, and then click the Login
button. Alternatively, press ALT + L. This opens the Login window.

& Note: It is not possible to log into a Graphic Hub installation by remote in single-user
mode (localhost) from other physical machines.

Start server: If the server on a listed Terminal is not running, it is possible to start the server
from this window. To do so, select the required server from the list, and click the Start
Server button. Alternatively, press ALT + S.

Start Naming Service: If the Naming Service on a listed Terminal is not running, it is possible
to start the Naming Service from this window. To do so, select the required server from the
list, and click the Start Naming Service button. Alternatively, press ALT + N.
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Active Sessions

From the Active Sessions window it is possible to monitor all logged in users and active sessions.
When faced with network or connection problems, checking active sessions can provide important
clues. Likewise, performance problems in general are easy to spot in the Active Sessions window,
since you can see hosts and servers. In sum, for a good clue as to where to find connection,
network and performance problems, look in the Active Sessions window.

Active sessions on server 'VGH-BIG-MAMA@VGH-BIG-MAMA®

Server: VGH-BIG-MAMA@VGH-BIG-MA! ~ | Running since: 45d, Sh, 29m, 58s Refresh interval: I
Started at: 15.10.2021 00:26:10 1 10 sec. 10

Sessions:
User Host IP address Host name (with domain) Host name Applcation Logged in since
Gerhard L 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-BIG-DADDY  Viz GH Rest 45d, o, 27m, 205
Gerhard L 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-BIG-DADDY  Viz GH Rest 45d, o, 27m, 255
Gerhard 1 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-EIGDADDY  Viz GH Rest 5d, 17h, 45m, 17s
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT.INTERNAL VGH-EIGDADDY  Viz GH Rest 23d, 22h, 50m, 37s
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-BIG-DADDY  Viz GH Rest 23d, 22h, 50m, 345
Admin 10.211.2.71 VGH-BIG-MAMA VIZRT INTERNAL VGH-BIGMAMA  Viz GH Scheduler 45d, oh, 27m, 235
Admin 10.211.2.71 VGH-BIG-MAMA VIZRT INTERNAL VGHEIGMAMA iz GH Terminal 45d, oh, 27m, 23s
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-EIGDADDY  Viz GH Rest 23d, 11h, 20m, 48s
Admin 10.211.1.126 FLORITZ.VIZRT INTERNAL FLORITZ Viz GH Manager ex... 155
Admin 10.211.1.12%6 FLORITZ.VIZRT INTERNAL FLORITZ Viz GH Manager 155
Admin 10.211.2.71 VGH-BIG-MAMA VIZRT INTERNAL VGHEIGMAMA iz GH Terminal Fu... 45d, oh, 27m, 23s
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-EIGDADDY  Viz GH Rest 45d, oh, 27m, 23s
Admin 10.211.2.71 VGH-BIG-MAMA VIZRT INTERNAL VGH-EIGMAMA iz GH Deploy 45d, oh, 27m, &8
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-BIG-DADDY  Viz GH Rest 45d, oh, 26m, 30s
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-BIG-DADDY  Viz GH Deploy Sche 45d, oh, 25m, 10s
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-EIGDADDY iz GH Deploy 45d, oh, 25m, 54s
Admin 10.211.2.72 VGH-IG-DADDY. VIZRT. INTERNAL VGH-EIGDADDY  Viz GH Rest 45d, oh, 22m, 30s
Admin 10.211.1.12%6 FLORITZ.VIZRT INTERNAL FLORITZ Viz GH Manager ex... 155
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-BIG-DADDY  Viz GH Rest 17d, 20h, 15m, 475
Admin 10.211.2.72 VGH-BIG-DADDY. VIZRT. INTERNAL VGH-EIGDADDY iz GH Deploy 45d, oh, 25m, 54s
Martin K 172.17.80.1 172.17.80.1 172 viz 2d, 15h, 40m, 155
Martin K 172.17.80.1 172.17.80.1 172 viz_bgl 2d, 15h, 40m, 155 W
< >

Session limit: 800 connections (System defauilt). Modify...

e

58 sessions running...

To Open the Active Sessions Window
Click View > Active Sessions. The following options are available:

Server: If logged in to more than one server, select which server to monitor from the Server
list.

Running since: Shows how long the selected server has been running, counting upwards in
hours, minutes, and seconds.

@ Tip: The time relates to the system time on the server machine.

Started at: Shows the time and date when the server was started.

Refresh interval: Defines the interval for when information should be refreshed. It can be set
to a value between one and ten seconds.

Message: To send a message to all clients that are logged in to the selected server, type a
text in the Message box, and then click the Send button.

The Sessions list shows detailed information about the sessions that are active on the selected
server. The following columns are available in the Sessions list:

User: Shows the name of the user that activated the session.
Host: Shows the host name of the machine that the session was started from.
Application: Describes the application and operation that the session belongs to.
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Logged in since: Shows how long the user has been logged in to the server, counting
upwards in hours, minutes, and seconds.

Last activity before: Shows the last time an operation was performed in the session.

No. of open files: Shows the number of files that are open in the system.

No. of locked files: Shows the number of files that are session locked.

Login time: Shows the time and date when the user logged in to the server.

Last activity: Shows the time and date of the last time an operation was performed in the
session.

Priority: Set the priority of the sessions for the correct load balancing.

Session rights: Shows the access (read/write) rights for the session.

Notifications: Description used by the clients, for example to inform that files have been
created.

Monitor Servers

From the Monitor servers window it is possible to view and analyze all servers that are currently
logged in to.

To Open the Monitor Servers Window

Click Tools > Monitor Servers. The left part of the Monitor Servers window lists all available

servers.

CMemorweves =loix
8 GrHfteplcstnnierer G- REFLICATION | e T ——— = ==
8 elhServonfaHERVER
@ Gl ServenZa-MN e Dk My

& Dk —- Totels  SEO0GE Toktal B0 R
@ Moy i~ (LTS AT Free £ T GE
@ Lo i Free: 228348 Lhied: 22168
& Hesth " FreaSh: LIS Used % ZTED%
& Chster Lt wTTE
Licerdas & Ml by
dkendy Capadonrhs: a Caly 41,540
e Bt R 12 Callitae 380
Fille opass ! [} Paak: 4.20
Fles a @ calie 145
Fhei iy [} @ peah: 45
e brarasctions 1]

=

The right part of the window shows details about one or more selected servers. If all the available
servers are working within the required parameters, this overview is hidden. If one or more servers
are in warning state, the overview for these servers open automatically.

To View Server Details

Double-click the server in the Overview panel or right-click the server, and select Open
Overview.
Select Open All Overviews to show details of all available servers.

Overview

The Overview frame shows a quick overview of all the parameters. A green light next to the
parameter indicates that all systems are normal. A yellow light indicates that there are non-critical
problems. A red light indicates that system limitations have been reached or there are serious
errors.
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—Overview
Disk,
Memory
License
Health
Clusker

]

The overview shows this basic information for the following parameters:

License
Disk
Memory
Health
Cluster
Activity

License

The License frame shows the status of the Graphic Hub license.

License
Expires:
In 176 davs.

The status shows license limitations or remaining number of days until the license expires. If your
license expires, you receive instant chat messages with increasing frequency to that effect.

Disk

The Disk frame shows the status of the currently used partition where the data directory is located
on the hard disk of the physical machine.

— Disk,
Takal: 538.00 B
IJsed: 36,17 GB
Free: 21.83 GE
Free %% 37,63 %
Lirnik: Q.77 GB

The status shows total, used, and free disk space, and also the warning limit. If the free disk space
reaches this limit, you receive an Alerts to this effect. The warning is also logged in the Journal
Panel. The warning limit is defined in the Preferences window.

Memory

The Memory frame shows an overview of the physical memory of the server both in numeric values
and over time.
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— Mermory
100 3 Tokal: 8.00 GE
Free: 6,82 GB
sed: 1.18 @B
=ed %a: 14.77 %

Health
The Health frame shows various Graphic Hub status parameters.
—Health

Deadlocks; 1]

Ackive sessions: 10

File opens: 262

Files: 4z

Files in memaory: 0

Deadlocks: Shows the number of deadlocks in the system. Any deadlocks necessitate the a
restart of Graphic Hub.
Active sessions: Shows the number of current sessions.
File opens: Shows the total number of opened files.
Files: Shows the total number of files stored in the system.
Files in memory: Shows the number of currently open files. If it remains greater than 1 for
an extended period of time, this may indicate locked files. In such cases, refer to the
following procedures:

Restoring Corrupted Files

Graphic Hub Manager and Viz Artist Troubleshooting
Open transactions: These are transactions that need to be deployed to the other server in
the replication environment. If the number is too high, stop working until it is back to zero.

Cluster

If you are logged into both main and replication servers, you are presented with a Monitor Servers
screen that reflects this.
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Title bar: Shows each server’s title bar shows its current status.
Cluster: Shows if the cluster is connected and healthy.

Open transactions: These are transactions that need to be deployed to the other server in
the replication environment. If the number is too high, stop working until it is back to zero.

Activity
The Activity frame shows an overview of the server activity both in numeric values and over time.
— Ackiviby
0 alls: 41,692
Callsfsec: 3.40
Peak; 3.90
@ callsfsec: 3.45
7 peak: 3.45

Calls: Shows the total number of calls made by any application to the Graphic Hub Server.

Calls/sec: Shows the average number of calls per second.
Peak: Shows the highest amount of calls during one second.

calls/sec: Shows the average number of calls during one second for the total run time of

the server.

@ peak: Shows the highest amount of calls during one second for the total run time of the

server.

Server Details

This window shows information about the folders and files stored in the Graphic Hub and loaded

into the memory.
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To View Server Details

In the Monitor servers window, click the Details button.

_ =10 x|
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(e 8

From the Refresh Rate drop down box it is possible to set the interval of when the
information should be updated.

Selecting the Show Functions check box shows additional information used for debugging
purposes.

& Note: Only users with administrator rights can access this window.
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Monitor details of server ...

Preferences
Refresh rate: |60 seconds ~ | show functions []

Total
Projects: 576 Folders: 45 831
Files: 3918 Size: 3,07 GB
Type Count 5™
W AUDIO_CLIP 7 12,53M
EIBASE_FONT 126 83,50 M
HFDNT 116 54,74 M
FDNT_FACE 0 0,00k
[GAFoNT_FLLE 0 0,00k
RS GEOM 99 5,99 M
B IMAGE 1854 1,95¢
mMAEF‘.IAL 0 0,00k
m:'MATERJAL_ADVANCED 1 8,00F »
£ >
Memory
Files: 0
FileType Cou ™
nAUDIO_CLIP
:1BASE_FONT
3ronT
3 FONT_FACE
EFDNT_FILE
G ceom
Eimace
X MATERIAL
[ MATERIAL _ADVAMNCED W
£ >

Close

The Total frame shows the following information:

Projects: Shows the total number of projects in the Graphic Hub.

Folders: Shows the total number of folders in the Graphic Hub.

Files: Shows the total number of files in the Graphic Hub.

Size: Shows the amount of storage space used by the data.

Memory: The memory pane displays the currently open files, counted per type.

Warning and Error Thresholds

Certain conditions that may cause problems or lead to errors are signaled by the Graphic Hub
when certain thresholds are crossed. An orange or red signal in the Overview indicates an issue
that should be investigated by the administrator as soon as possible. In addition, the Graphic Hub
provides a warning on shutdown, if one or more of the following conditions apply:

Less than 1,600 MB hard disk space is available.
More than 99 % physical memory is used.
Less than 100 MB virtual memory is available.
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© IMPORTANT! If less than 50 MB disk space is available, Graphic Hub does not allow
any write operations, such as file create, truncate, or copy.

In the Overview, Warning level issues are indicated by an orange parameter light, and
suggests that a restart is recommended. Critical level issues are indicated by a red
parameter light, and suggests that a restart is necessary. Check the log files for further
details. The following table lists the most critical limits and warnings:

Hardware Limit Mode Usage Limit, Journal Warning

Less than 1,000 MB free disk space Localhost, 5/4 Critical disk space error. Only read
Free, access, no write operations
Multiuser permitted

Less than 10,000 MB free disk space Main/ Critical disk space error. Only read
Replication access, ho write operations

permitted
Less than 2 % free disk space or less All Journal warning: Hard disk limit
than 5 % free disk space if 1 % of total almost reached

disk space is less than 10,000 MB

95 % or more physical memory used All Journal Warning: Suggests a restart
is recommended

100 % Physical memory used All Journal Fatal Error: Suggests a
restart is necessary

250 MB or less virtual memory available  All Journal Warning: Suggests a restart
is recommended

100 MB or less virtual memory available  All Journal Fatal Error: Suggests a
restart is necessary

In addition to the situations described in the above table, the following conditions produce a
journal warning:

25 or more main/replication server switchbacks have occurred.

250,000 or more total open transactions have been processed.

7,500,000 or more critical calls have occurred (file created, truncated, written, replaced,
copied, references changed).

9,000 or more total number of files (index information) in memory

48,000,000 or more total file opens.

2,000,000,000 or more total calls.

Main, folder, keyword or file index data file size exceeds 1,536 MB.

The following conditions produce a journal critical error:
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30 or more main/replication server switchbacks have occurred
500,000 or more total open transactions have been processed
8,000,000 or more critical calls occurred (file created, truncated, written, replaced, copied,
references changed).
10,000 or more total number of file (index information) in memory.
50,000,000 or more total file opens.
2,100,000,000 or more total calls.
- A deadlock has been detected.
Main, folder, keyword or file index data file size exceeds 1,740 MB.

Server Properties
The Server Properties window shows the following types of information:

General server information.
Checksum information. To view Server Properties, right-click the server and select Properties
from the Servers and Folders panel.
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Properties for server 'GHMainServer@GH-MAIN B

Patner. GHRepheationServer@GH-REPLICATION

S e S General
EH Checksum
MName; GHMainServer@GEH-MAIN
Type: I
ersion: 300060132
File infio: Clusiter mfo
Progects: 1
Folders: 0 Type:  Replication
Files: N/
Size: 0.00 KB
Dretads...
Licarme: Expres: In 176 days.
Diigk:
Total 58.00 GB
Used %17 GB ‘
Free: 21.83GB ;
Free %: ek CEr——m
Lirrak: 977 GE
M emany:
Total 200GE
Free: E11 GE
Uged 1.83GB
Used % 2357 %

0k

Runining snce: 3h, Z1m, 2/s
Started ab: 3/8/2016 11:36:49 AM
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Health
Drisk
Memory
Licenze

L

Cluster

“

Froperties...

iy

Cancel |

e

In addition to the server’s name, type and version, general server information includes:

License

Disk

Memory
Health

Server details

Checksum Information

View the checksum when you want to compare two or more Graphic Hub servers to see how
identical they are. This is useful after having performed replication operations or when you have a

real-time Deploy Agent. Empty servers have a checksum of 00 .
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E Chﬂﬂ-ltg Lm

M ame: GH M ain5 ervent@iE H-bdb Health &
: Disk. i

Type: b ain Memory. @

W erzion; 3.0.0.60132 Licenze @&

Total zerver checksum: BED4423938494E 4

Falder structure anly: 10DDOECAT 2E 7ABEE3

Folder structure incl. file data;  BBCAB1BAFBAFE4ES

File data only: E9REE 20120 84CRBOD

File references only: BI1EFE4EZB0ERACE

Pilat tables: 018071 EZ71D93783

Checksums of the other gerver(z] where logged in: Refrezh |

= B GHReplicationServer@EH-REPLICATION
BB Total server checksum (BB D 4423938494E 4]
m Folder structure only [1DDOECATZETASEES)
. Folder stucture incl. filedata [BACAETEBAFSAFE 4EE]
W3 File data only (5356B301 2D34CE0D)
File references only [B316FE4E 280ERACE]
B Filat tables [D15071E271093783)

The checksum calculation may take a long time depending on the databaze sizel

Use the Refresh button to update the checksum information for the servers currently logged on to.
Checksum information includes:

Total server checksum

Folder structure (including file data)
File data only

File references only

Pilot tables

Empty servers have a checksum of 00 . When logged on to more than one server, right-clicking in
the checksum information window brings up the contextual menu, which gives access to:

Open differences...: Opens the Server Diff window. From this window, it is possible to detect
differences between the servers (see Detect and Solve Server Differences).

Open differences and execute...: Opens the Server Diff window and executes the Diff all
operation.

A Note: Execution time of Diff all varies depending on the database size and the
amount of differences between the servers being compared.

Open Pilot differences...: Opens the Pilot data differences window. See Resolve Viz Pilot Data
Differences Between Graphic Hubs. This option only appears when connected to a server
that contains Pilot data.

Properties: Opens the General server information window for the selected server.
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Chat with Artists

Users can communicate with each other while logged in to Graphic Hub. This chat functionality is
also used to receive global messages from Graphic Hub, such as information about a system
shutdown. The messages that are sent and received are saved throughout the session. If your
dongle expires or is otherwise invalid, you receive messages in the chat panel with increasing

frequency until you renew it.

@ Tip: The chat feature is available from both Graphic Hub Manager and Viz Artist.

Servers, groups and users: Mesrages:
& Global Mescage <UIBIH016 2:55:29 PM> [VieDbSarvenDEHSERYER- »Sarver]: Wiz Graphic Hub is running
= () GHMainSarven@GH-MATNadmin)
=1 {5 Administrator
% Admn
= (4 GHReplcationServen@GH-REFLICATIONA
=] () Adeministrator
by Admin

To send & messags bo the seleched sarver, group, of user, bype a message in the box,

To Open the Chat Panel
Click View > Messages (Chat).

& Note: If receiving a message while the Chat panel is hidden, the panel automatically
opens.

To Send an Instant Message

f—

. Open the Chat panel.
2. Select the recipient from the left side of the panel.
3. Type a message text in the text box, and press ENTER. The message is sent to the selected

Graphic Hub Manager and/or Viz Artist user(s).

@ Tip: Messages sent to Global Message are delivered to everyone. Messages sent to a
group are delivered to every group member currently logged in.

Object Types

From this window you can view all the folders and file types on a selected server.

Copyright © 2023 Vizrt Page 121



Graphic Hub Administrator Guide - 3.8

To View Objects
Click View > Object Types .

Object types on server 'VG...

Server: | WGH-BIG-MAMA@VGH-BIG-MAM ~

Object
Id Name
-l Folder

W2 Project

K47 MATERIAL

KBl scenE

Eie mace

KEso  cEom

K51 ronT

E 148 BASE_FONT

EY 167 SHARED_MEMORY_MAP
K195 AUDIO_CLIP

[EF 212 MATERIAL_ADVAMCED
K248 VIDEQ_CLIP

256 SUBSTAMCE

B8 274 MATERIAL_DEFINITION
314 RUNTIME_TECHNIQUE
83159 FONT_FILE

321 FONT_FACE

Close

ObjectTypes: 17

1. If logged in to more than one server, select which database to monitor from the Server list.
2. Each folder or file type is shown with its corresponding ID. Once an object is in the database,
its type is added to the object types list. The type remains in the list even if all files of that

type is deleted later on.

2.5.12 Daily Backup Using a Second Graphic Hub

Adding a backup server adds another level of redundancy to the Graphic Hub server. This section
describes how to configure and restore from a Graphic Hub backup server in running in 5/4
Free mode.
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Graphic Hub (Main) Graphic Hub (Replication)

GH Deploy Agent
with real-time deploy task

Graphic Hub (5/4 Free)
with periodic backup

To Configure a Graphic Hub Backup Server

1. Install a Graphic Hub server in 5/4 Free mode on an extra machine.

2. Open Backup Configuration in the Graphic Hub Terminal, by clicking Backup and
selecting Show configuration from the Backup and Restore menu.

3. Configure the server To Do an Internal Backup or To Do an External Backup.
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4. Make sure to check both the Automatic backup after successful shutdown and Start after
backup checkboxes.
BACKUP COMFIGURATIOMN

Disabled
ﬂ Internal Backup
Backup directory®* : ChBackup Folder

Cleanup restore points  ¥)

External Backup

ALTOMATIC BACKUP SETTIMGS (MIUST BE SET BEFORE GRAPHIC HUE SE RWER START)

Autornatic backup after successful shutdown

5. Start the backup server.

6. Using Graphic Hub Terminal, Graphic Hub Manager or Graphic Hub REST, configure a shut
down task to shutdown the Graphic Hub periodically, for example once per day or once per
week, depending on the requirement.

7. Install a Graphic Hub Deploy Agent on the failover system. If there is no failover system in
place, the replication server should be used.

8. Create a real time deploy task from the cluster towards the backup server, without
emergency pausing.

© Caution: Because of the resource requirements for the Deploy Agent, it is not
recommended to install the Deploy Agent on a cluster’s main server.

To Restore from Graphic Hub Backup Server

1. Pause the deploy task on the cluster.
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2. Perform an emergency shut down of the backup system. Make sure to check the Temporary
disable backup after shutdown checkbox:

Emergency Shutdown

A Are you sure youwant to perform an ernergency
shutdown?

Motea: An automatic backup after shutdown is configured!

Ternporary disable backup after shutdown

Mo

© Warning: If the backup after shutdown task is not disabled, the backup task runs and
restarts the server afterwards, which can result in possible loss of data.

3. To go back to a specific backup, create a restore data directory from the Graphic Hub
Terminal restore points. Then configure the Graphic Hub backup server to start using that
data directory.

4. Log on to the cluster and backup servers with Graphic Hub Manager.

5. Click Server in the main menu and select Differences... to open the Server diff window.
Deploy all differences from the backup server to the cluster.

@ Tip: Use the Manager to search for specific files and copy them from the backup
server to the cluster, if not all differences are to be restored.

2.5.13 Detect and Solve Server Differences

If a Graphic Hub in a Cluster environment switches from real-time replication to recovery mode, or
the replication server has been performing a cluster rebuild, the data on the servers may differ. In
such situations, the Graphic Hub may be unable to do an automatic rebuild.

To Detect and Solve Server Differences

1. Make sure that the Main and Replication servers are up and running.
2. Open Graphic Hub Manager on a third machine, and log on to the Main and Replication
servers. The user account on the Replication server must be an administrator user. Check
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the As system administrator checkbox in the Login window when logging on to the server:

Pt Login *
Preferences...

Connection

Hast: | TUTORIAL2 v

Hub: VizDbServer

Hub type: Replication server
User
Mame: Adrnin A

Password:
I Az system administrator I

[ ]Enable for Auto login
Viz Graphic Hub wversion: 3.0.0.60023

Client version: 3.0.0.53968

Status: Connected to server 'VizDbServer@TUTORIALZ',

3. From the main menu, select Server > Differences.

_’: almi=
[T L.I

'Prﬂm_ Pies T} | Fokders 130 | Enyeecrc (0 | Do Lok 5| i utew e | P o8 Stk S 80 | Aorm i dgpd 004151 |

e 3 P Sl gt e BB AT | B et
e s

I o o T |
7 S g i

[ -

Fiei

Trst arvy Evpm =
7 Bgpew vt st bacms of histary ook

[ Comparn vt semifind Robdersirofents i

f L]
I =

F

klil‘# et G e e AR LTI e ek s e e b AT R

4. In the Server Diff window, click Diff All. This scans all files on the selected servers.

5. Sort the entries on both servers by size (click the Size columns), and then delete all files with
a size of 0.00 KB.

6. Click Diff All again.
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7. Now sort the entries by type, and then select all entries of type Scene, where the row on the
opposite side is labeled missing.

10.

Size

/A

4,638,138

NJA
NJA

12,886,487

NJA
N/A
NJA

3,447,352

NJA
N/A
NJA
NJA
NJA
/A
NJA

3,447,351

NJA

4,687,705

Type

IMAGE

IMAGE

TMAGE

IMAGE

IMAGE

Files {15) I Folders (12) I Keywords () ] Deploy tasks (0) ] Viz uger settings (0) ] Viz VR Studio Setups (0) ] Add-ons (0) ] Assigned add-ons (0) }
Mame Size  Type Date modified Mame
5 s_onlydeldata_ok 6,293 SCENE 11/19/2015 1:40:... |53 missing!
B missing! N/A B uffizi_cross_hdr
Elimg_5_deldata 1,302,921 IMAGE 11/19/2015 1:29:... [ missing!
Edimg_1 ok 1,302,921 [IMAGE 11/19/2015 1:28:... | missing!
B missing! NjA B4 bg-douds
Es_3_al_upd 6,585 SCENE 11/18/2015 1:30:... I3 missing!
535 _onlyupd_upd 6,239 SCENE 11/19/2015 1:41:... |3 missing!
s 1 al ok 6,585 SCENE 11/19/2015 1:29:... |5 missing!
[ missing! N/A |4 ABER_TEST_-_Copy_-_C...
s _onlyupd_ok 6,239 SCENE 11/18/2015 1:41:... I3 missing!
Es_5_all_deldata 6,585 SCENE 11/19/2015 1:39:... 3 missing!
&s_4_al_empty 6,585 SCENE 11/19/2015 1:38:... |5 missing!
Elimg_4_empty 1,302,921 IMAGE 11/19/2015 1:28:... [ missing!
=l s_onlydeldata_deldata 6,293 SCENE 11/19/2015 1:41:... |5 missing!
s 23 del % Tt T Seleminnam s ] missing!
Wdimg_2_del DDC to server 'VizDbServer@7422-DRU'... § missing!
nrrlsgwgl Verify/restore... 'A_BE?'—TEST—_—COWJHQ
Eiimg_3_upd § missing!
i missing! Delete... Del § inter

Properties...

Date modified

2/13/2018 1:01:0...

2/13/2018 1:01:0...

1/26/2018 9:47:1...

1/26/2018 9:47:1...

2(13/2018 1:01:0...

Right-click the scene entries, and then from the menu that appears, select DDC To or Verify/

restore...

In the Deploy Direct Copy window that opens, click Continue. Or analog to this click Verify in

the Verify/restore... window.

The Action Log for deploying files is activated. In the resulting window that opens, click
the Move button.
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The entries are deployed from one server to the other.

4 Deploy Direct Copy - Analysis & Options — O x
Summary
- Destination path: GHMainServer@GH-MAIN: (data
Available disk space on server 'GHMainServer @GH-MAIM': 14.99 GB
Selected objects: = 47.82KB 47.82 KB
Referenced objects: 0 0.00KB 0.00 KB
All objects: 4 47.82 KB 47.82 KB
Analysis
B Image_4 (IMAGE - 10.70 KE)
Image_3 {IMAGE - 15.39 KE)
B Image_2 (IMAGE - 13.64KE)
B Image_1 (IMAGE - 8.10 KE)
Infos, warnings & errors
Info: Analysis finished without any warnings or errors!
Step 5 - Analyzing objects on the target server: 4of 4
Behavior options
Rebuild original structure -
Cwverwrite existing objects (Does not apply to referenced objects)
Overwrite existing references |:| Overwrite creation date
Owverwrite owner []owerwrite modification date

11. Repeat steps 7-10, and this time sort the entries by type Geom.
12. Repeat steps 8-10 for all other entry types.

2.6 Viz Pilot Database Management

This chapter describes management of Viz Pilot databases when the Graphic Hub is used as a Pilot

data back end server.

In this section, you find the following information:

Important Pre-installation Information
Schema Changes
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Important Pre-installation Information

Before setting up Graphic Hub as a back end database for Viz Pilot, observe the following:

- The server must meet the minimum hardware requirements for Graphic Hub as Viz Pilot
back end system which may vary depending on the size of the installation.

- Viz Pilot requires Graphic Hub REST . The server running the GH REST service needs to meet
the Graphic Hub REST Requirements.

The schema version is bound to the Graphic Hub version:

Graphic Hub Version

Graphic Hub 3.6.0 - 3.7.0

Graphic Hub 3.4.0 - 3.5.2

Graphic Hub 3.2.0 and
3.3.0

Graphic Hub 3.0.2 - 3.1.1

Graphic Hub 3.0.0
and 3.0.1,

Graphic Hub 3.4.0 - 3.4.2

Graphic Hub
3.2.0and 3.3.0

Graphic Hub 3.0.2 - 3.1.0

Graphic Hub 3.0.0
and 3.0.1

Pilot Schema Version
6, 7, 8.0, 8.3.0, 8.4.0 and 8.7.0
! Use Graphic Hub REST 2.6.0 or

later to expose all 8.7.0 schema
changes.

6, 7, 8.0, 8.3.0 and 8.4.0

! Use Graphic Hub REST 2.4.2 or
later, as 2.4.0 and 2.4.1 fail to
expose all 8.4.0 schema changes.

6, 7, 8.0 and 8.3.0

6,7 and 8

6 and 7

To clean the schema

To clean the schema

To clean the schema

To clean the schema

Copyright © 2023 Vizrt

Import Using

Graphic Hub Manager
version 5.6.0

Graphic Hub Manager
version 5.4.2 through 5.5.2

Graphic Hub Manager
version 5.2.0 or 5.3.0

Graphic Hub Manager
versions 5.0.2
through 5.1.1.

Graphic Hub Manager 5.0.1

Graphic Hub
Manager 5.4.2, 5.4.1
or 5.4.0

Graphic Hub Manager 5.2.0
or 5.3.0

Graphic Hub Manager 5.1.0
or 5.0.2

Graphic Hub Manager 5.0.1
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- All Pilot data is stored in the configured data directory. It is included in the Graphic Hub
Terminal internal backup, and when the data directory is copied.
- The schema is automatically upgraded when the Graphic Hub is started on a data directory.

Graphic Hub Version Upgrade to Schema
Graphic Hub 3.6.0 - 3.7.0 8.7.0

Graphic Hub 3.4.0 - 3.5.2 8.4.0

Graphic Hub 3.2.0 and 3.3.0 8.3.0

Graphic Hub 3.0.2 - 3.1.0 8

Graphic Hub 3.0.0 and 3.0.1 7

In general, old Pilot clients can work on newer Graphic Hub and Graphic Hub REST versions,
but newer Pilot clients cannot work on older versions.
- Schema 7 clients (VCP 7, 7.1, 7.2) and 8 clients (VCP 8, Pilot Edge) can work on GH
REST 2.0.2/GH 3.0.2 and higher.
- Schema 8 clients (VCP 8, Pilot Edge) can not work on GH REST 2.0.1/GH 3.0.1 and
lower.
- Schema 8.3.0 clients can work on GH REST 2.2.0/GH 3.2.0 and higher.
- Starting with PDS 8.4 and Pilot 8.5, all future Pilot releases will be able to work with all
future GH versions greater than version 3.3.0,
with potentially reduced functionality when used with older GH/GHRest versions.
Therefore it is recommended to keep the versions aligned.

© Important! Make sure to have the documentation for Graphic Hub and Viz Pilot at hand
before proceeding with the installation. The latest documentation is available
at www.vizrt.com.

Version Requirement Summary

Pilot Schema Version Graphic Hub GH REST GH Manager Version

Pilot Client Version Version Version to Import / Clean
Schema

8.7.0, Pilot 8.5.0 or 3.6.0, 3.7.0 2.6.0,2.7.0 5.6.0-5.7.0 can import

newer, Pilot Edge using schema 6, 7, 8, 8.3.0,

8.7.0 schema 8.4.0, 8.7.0
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Pilot Schema Version Graphic Hub GH REST GH Manager Version
Pilot Client Version Version Version to Import / Clean
Schema

8.4.0, Pilot 8.5.0, Pilot 3.4.2, 3.4.1 (avoid 2.4.2 (avoid 2.4.1, 5.4.0, can import

Edge using 8.4.0 schema 3.4.0) 2.4.0) schema 6, 7, 8, 8.3.0,
8.4.0

8.3.0, Pilot 8.3.0, Pilot 3.2.0 or 3.3.0 2.2.00r 2.3.0 5.2.0 or 5.3.0, can

Edge using 8.3.0 schema import schema 6, 7, 8,
8.3.0

8.0.0, Pilot 8, Pilot Edge  3.0.2 through 3.1.1 2.0.2 through 2.1.1 5.1.1 or 5.0.2, can

using 8.0.0 schema import schema 6, 7, 8
7.0.0, Pilot 7, Pilot 7.1, 3.0.0 or 3.0.1 2.0.0 or 2.0.1 5.0.1, can import
7.2 schema 6, 7

© Important: Always use the correct versions as listed above. Do not import Pilot data or
clean the schema on Graphic Hub 3.0.2 or higher with GH Manager 5.0.1 or 5.0.0, as this
writes the wrong schema version to the Graphic Hub.
Manager 5.0.0 with Graphic Hub 3.0.2 or higher:
- Clean: Sets schema version number to 7.0.0.

Import: Sets schema version number to 6.0.0.

Manager 5.0.1 with Graphic Hub 3.0.2 or higher:
- Clean: Sets schema version number to 7.0.0.
Import: Does not overwrite present schema version.

2.6.2 Schema Changes

The following schema changes are performed automatically on Graphic Hub startup.

7.0.0 (Graphic Hub 3.0.0, 3.0.1) to 8.0.0 (Graphic Hub 3.0.2 or higher)

Adds three additional columns to the templates table:

- authored_model STRING NULL WITH DEFAULT NULL
- master_template_modified DATE NULL WITH DEFAULT NULL
- authored_model_modified DATE NULL WITH DEFAULT NULL

8.0.0 (Graphic Hub 3.0.2 to 3.1.1) to 8.3.0 (Graphic Hub 3.2.0 or higher)

Adds an additional column to the templates table:

- template_kind SHORT NOT NULL WITH DEFAULT = 0
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8.3.0 (Graphic Hub 3.20 or 3.3.0) to 8.4.0 (Graphic Hub 3.4.0 or higher)
Adds an additional column to the templates table:

master_template_xml STRING NULL WITH DEFAULT NULL
Adds additional columns to the template_concepts table:

- template_thumbnail_type SHORT NOT NULL WITH DEFAULT =0
- template_thumbnail_text STRING NULL WITH DEFAULT NULL
- thumbnail_last_modified DATE NULL FOREIGN KEY WITH DEFAULT NULL

8.7.0 (Graphic Hub 3.6.0 or higher)

Adds an additional template_script_html table with the following columns:

- template_id BIGINT NOT NULL PRIMARY KEY

- type_script STRING NULL

- java_script STRING NULL

- created DATE NULL WITH DEFAULT SYSDATETIME

- created_by STRING NULL WITH DEFAULT = 'PILOT'
modified DATE NULL WITH DEFAULT SYSDATETIME FOREIGN KEY,
modified_by STRING NULL WITH DEFAULT = 'PILOT' FOREIGN KEY

See Also

- Viz Pilot official documentation
Pilot Clients Have No Database Connection

3.8

2.6.3 Key Features and Workflow of Graphic Hub 3 as Viz Pilot Back-

end System

Key Features and Workflow of Graphic Hub 3 as Viz Pilot Backend System

- Centralized storage for both Viz Engine graphics and Viz Pilot data.
Easy setup of main and replication in terms of redundancy and fail-over.
Easy installation without any extensive database knowledge or upgrade procedures.
Easy import of data from Oracle to Graphic Hub using GH Manager.

- Cloud-ready back end based on REST. Note regarding security: GH REST supports SSL. Key

creation and certificate distribution is not handled by the Graphic Hub, and is the
responsibility of the customer.

Easy Ul-driven import from a running Oracle database on Viz Pilot schema version 6, 7 or 8
to the Graphic Hub via the Graphic Hub Manager. The import only has to be done one time

in the transition phase. Note that re-import deletes all previously imported data and all
changes.

- The feel of working with data on a Graphic Hub is exactly the same as using the back end

database on Oracle.
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Notable Limitations

- Graphic Hub as pilot back end requires Graphic Hub REST and specific versions (see Viz Pilot

Database Management).

- One schema per Graphic Hub instance. Graphic Hub can run a single Pilot schema on same

instance as graphics data, as opposed to Oracle, which can run multiple.

- The schema version is bound to the Graphic Hub version.

No support for master-to-master replication through Graphic Hub Deploy Agent. A manual
backup solution is possible with Graphic Hub manager (see Data backup solution). Since
Deploy Agent 2.2.0, it is possible to schedule deploy tasks which automatically backup Pilot
data to other Graphic Hub instances.

- VOS (Viz Object Store) is not supported in Graphic Hub.

Basic Setup

These are the steps to set up Viz Pilot with Graphic Hub as back end with existing Pilot data
schema version 6, 7 or 8:

1.

2.
. When both installations are complete, the configuration windows for Graphic Hub Terminal

Install Graphic Hub (see To Install a Graphic Hub. You may configure a new and empty data
directory or use an existing one.
Install Graphic Hub REST (see To Install the Graphic Hub REST.

and Graphic Hub REST open automatically in the browser.
In the Graphic Hub Terminal window, click Start Server to start the Graphic Hub server.

. Switch to the Graphic Hub REST configuration window. Select the local Graphic Hub (if

gesired) as Graphic Hub server, and click Apply:

-
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6. Log on to the Graphic Hub as Admin . The default password is VizDb :

Authentication required

Please login to Graphic Hub:

VizDbServer@LOCALHOST-19396

GH usermame : Admin

GH password : (TIL L

7. Install the Graphic Hub Manager and start the application from the Start menu when the
installation has finished.
8. Log on to the Graphic Hub server running on LOCALHOST as Admin:

Bt Login e
Preferences...

Connection

Host: LOCALHOST w

Hub: VizDbServer

Hub type: Standard server

User

Mame: Adrmin =

Password: | LT L]

[ ]Enable for Auto logini
Viz Graphic Hub version: 3.0.0.59212

Client version: 3.0.0.59154

Status: Connected to server 'VizDbServer@LOCALHOST',

9. Go to Pilot > Import...
#t viz GH Manager - using Layout 'System-Clean (locked)'

Server View Tools Exra  Pilot  Info

IE' S0 Addres Differences...

Servers and folders Import...

/U'E'g Servers and fnlders\(:'ul Search % -
~ [ 1-vizDbServer @LOCALHOST{Admin)
> data
10. Proceed to Import Viz Pilot Data Schema.

3.8
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& Note: Requires that the Pilot data schema is at least version 6, 7 or 8, depending on
the software versions in use.

All data from Oracle is now in the Graphic Hub. Click Finish.
Install Viz Pilot Data Server.

In the installer select Graphic Hub as database connection and enter the connection details
of GH REST.

& Note: The specified User ID must be a Graphic Hub user without a password, and
minimum Write user rights.

ﬁ Vizrt Pilot Data Server 7.0.0.764 Setup = XS

Setup Database Connection
The Pilot Data Server service must be configured to connect to a
Graphic Hub or Orade database.

Connection method
[Graphir_ Hub -

Host name

|I|:u:alh|:|st

Port number

|19398

User ID
|Guest

Back ][ Mext ] [ Cancel
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Filter :

Asset search providers

ile and Folde rch for

=
LIRSS VizDbServer@LAB-PDS

ch for iter

Pre-authenticated hosts

Admin

admin

15. Set disable_built_in_vos_search.

Setting to disable the clearing of all |
ton in Viz Pilot
n with plugins

from Viz

1y timelines for clip assets that has an

ch. T ould

ble_unique_name_check

This enables the Director to search the Graphic Hub for media.
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16. Install Viz Pilot 7 or newer. When the installation finishes, the Pilot configuration opens.
Select GH as Database and enter the connection details for the Graphic Hub REST.

K Viz Pilot Configuration

General Preview Mewsroom Wizard
F§1 Database
Connection Type
SID

Hostname

localhost
Port

19398

Username
Guest

':j Media Sequencer

Media Sequencer Host
localhost

17. Configure the other options, such as Preview, as required.

18. Install Media Sequencer 4 or newer.

19. Install Preview Server 3 or newer.

20. Start Director, then go to Tools > Media Sequencer Configuration.
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21. In the Database tab, Select Pilot Data server.
Media Sequencer Configurati

Database Viz One MOS

O Pilot Data Server
Host :
Part :

@ Oracle

Immediately remove deleted elements

1. Restart Director. The following icon should appear in the bottom right: S

- Director has already had a status icon in the bottom right corner that told the user
about the status of the database connection of the Media Sequencer. It is still there
and works regardless of the configured back end system. It uses a new icon, but
works the same way. When green, it means the Sequencer is connected to a Pilot
database. However, the icon is also green when the connected database is different
from the one that Director connects to. For example, Director may connect to Graphic
Hub, while the Sequencer connects to Oracle. In this case, the configuration needs to
be changed. If the icon is not green, there is a problem with the Media Sequencer's
database connection. Check the Sequencer logs for further troubleshooting details.
If the Media Sequencer Configuration's Database tab in Director looks the same as
prior to upgrading to Pilot 7 or newer, it is because it is connected to an older Media
Sequencer that does not support connecting to a Pilot Data Server. Media Sequencer 4
or newer is required for Pilot 7 or newer.

Notes

With the Graphic Hub setup, the Media Sequencer, clients, and Pilot Data Server need to be
able to Graphic Hub REST across the network.
Media Sequencer needs access to the Pilot Data Server.
The Graphic Hub database connection needs to be configured in three locations:
For client applications by using the Pilot Configuration tool, as outlined above.
For Pilot Data Server by using the installer, as outlined above.
For the Media Sequencer by using Director configuration, formerly known as External
Interfaces.
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When started, Director and Template Wizard now uses Graphic Hub as the back end
system.

2.6.4 Main and Replication Servers

Pilot Data High Availability Cluster Solution (Main/Replication)

As with previous Graphic Hub versions, each modifying statement in a cluster environment is
replicated towards the Replication server to guarantee real-time redundancy. This means that all
items, including the Pilot data on the main instance, are replicated to a second Graphic Hub
instance in real-time. In case of a fail-over situation, all connected clients on the main instance are
automatically redirected to the replication server. As soon as the main server resumes operation,
all items created or modified in the meantime are automatically transferred from the replication
server to the main server.

To check if main and replication are in sync, connect to both Graphic Hubs as an administrator
user using the Graphic Hub Manager, then proceed to check for Pilot Server Differences.
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Graphic Hub (Main) Graphic Hub (Replication)

Graphic Hub REST

Data Server

Viz Artist/Engine
Media Sequencer

Wiz Pilot Viz Pilot ActiveX

2.6.5 Import Viz Pilot Data Schema

This section details the import of an Oracle Viz Pilot Schema to the Graphic Hub. For information
on the use of the imported Oracle Viz Pilot Schemas, refer to the Viz Pilot documentation.
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data.

© IMPORTANT! You must be logged on to the Graphic Hub as an administrator to import Pilot

© IMPORTANT! Always use the correct software versions as listed in Viz Pilot Database
Management. Do not use GH Manager 5.0.1 or 5.0.0 to import Pilot data or clean the
schema on Graphic Hub 3.0.2, as this writes the wrong schema version to the Graphic Hub.

To Import a Viz Pilot Schema from Oracle

1. Click Pilot > Import to open the Import Pilot data window:

Trmport Pilot data )

1~ Dracks datisbase

connechon siing

_Il'fmtliﬁnlr

Host [Hioet_Higms

Frotocol  [TCP

Patt pﬂ1

Service

[#zrToe

Usar pumxm

Pasword Ii LTI ET

Server o imgoe bo
HM a5 e

Veily cornection_ |

[ Dot it
™ Duebets Fikok data
% Diete and import Plot data
™ Ordyimport Bvary data clemerts

Hest » Cacel | Heo |
p

@ Tip: The Import History shows a log of previously imported Viz Pilot schema.
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2. Enter the parameters to access a Viz Pilot schema on an Oracle database:

— Oracle databaze connection sting [ —
Host IHl:-st_N ame
Protacal ITEP
Port I'I 521

el IVIEHTDE

| zer ILlserN ame

Password I““"“

Host: Enter hostname or IP address for the Oracle database. IP address is
recommended.

Protocol: Select the connection protocol: TCP or UDP.

Port: Enter the port number of the Oracle database.

Service: Enter the database name of the Oracle instance.

User/Password: The user credentials required for the schema to be imported.
Connection string: (Optional) Check the connection string checkbox and enter an

Oracle database string to connect to the Oracle database:
Oracle databaze conreatTg

Connect I

® Example: Data Source=(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)
(HOST=10.211.2.11) (PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=VIZRTDB))) ;User
Id=pilotdb;Password=pilotdb;

3. In the Server to import to drop-down menu, select the Graphic Hub to import to. A dimmed
drop-down menu means the menu is unavailable because the Manager is logged on to only
one Graphic Hub.

Server to import ko

| GHM ainS erver@EH-MAIN(Admin) =l

4. Click Verify Connection... to verify the connection details and check if an import can be
done. If the connection details are verified, this connects the Manager to the Oracle
database.

A Note: An import does not work if the schema version does not match the Graphic
Hub version, or the Graphic Hub version is below 3.0.0.

5. Select the Import Settings:
Delete Pilot data: Erase all data and sets up a clean Viz Pilot schema.
Delete and import Pilot data: Clean all and import new data.
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Only import library data elements: When checked, only Data Elements marked as

Library Element are imported.
6. Click Next to view the elements marked for import to or deletion from the Graphic Hub
database:

rmipodt pilot data - | *

Impod to sanver Wit b Sermen@LOCALHOST

Progress

TOT,

Searted: WA Finishecd m: MR

Wiz GH Ceanup Imgecat From Oracle Progress log

Tl Crides Proom Tatde Erires  Proces = Tima e i-]
chargeiag 1] lrmept 4 10:85:37 Creating connection to GraphicHub
VIR _param L conirel_sos 4 105538 . Genersting kst of 1abies and the rumber of ther
Frobe_planyieit ] (-] ] 10:56:04 Settings Upiaiad
panch_pes o E_piriph_uris 1 10:56:26 Settrgs Lpdaiad
e _ e o oeraraend_ 135 10:56:26 Denerating kst of {abias and tha rumber of ther
dhament_th o plakeat_irfis 157
mhmmenis 1] bemplate o 195
varant_oon i bamplate U ]
varants 2 plakcat_wari 170
CAlBgones i bemplate_c 150
oulpul_chas i} bemplate U i
\ng_bempiat o £ _templabe 1
Inepinle_y ] Eag_template 0
lnmplaln_u o w cutput_cha ] ~

L4 * € *

Open log deschony...
<o e

The Pilot data import progress window displays the number of entries that will be cleaned or
imported from the database tables, as well as a progress log. Depending on the selected
Import settings, this stage have an Import or Clean button:

If Delete Pilot data was selected, the button is labeled Clean....

If Delete and import Pilot data was selected, the button is labeled Import....

7. Click Import or Clean depending on the selected task. The time to completion of this task

depends on the number of tables and elements to be cleaned or imported. The progress bar
provides a quick overview of the process, as well as the start and estimated end times.
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8. When the import is finished, an alert window pops up with information about any errors

encountered during the import:
Viz GH Manager >

1 warning cccurred during import:

*Invalid UTF & char found in table plakat_data! Check log file for
celumn infermation

OK

9. Click OK to return to the import Pilot data window. If any errors were reported, click the

Open log directory... button to access the import log files.

Impoert piliot dats - m|

Impod fo sarver VizDb Sermen@UOCALHOST

Progress
TOTAL

Seavtec: Z2Jul-16 1056 AM  Finisiecd it 22016 11:00 AM

Wiz GH Cleanug It From Orscle Progress log

Tkl Eriries  Proces & Table Eriries  Proces Tima L] !
" vmand_gon ] ' E_bermpiate_ 1 5647 .. Settings Lpdaied?

W viriants F ' Eag_lemplate [ 10:56.47 Generating list of 1abies and the rumber of ther
W' chtegonies ] W cutpul_cha... 2 10:56:47 _  HEWIMPORT JOB_
W oulgal_cha ] ' eabegony 2 10:56:47 Sepping sl Aotiications

' lng_bemplet . ] v wariart i k1 10:56:47 Lisckirsg plot tabies

v lemplaie s /] v wariant_con &3 d 10:56:47 Impaorting From: ([DESCRIFTION=(ADDRESSs],
W lemplaie_u 1] v plakcat_data 7.386 738 105647 Impaorting To- VizDbServer@LOCALHOST: 1535
' lomplste .. 0 wpltkat deta . 7,386 7.3 15647 . Migrating tables from OracieDB to Viz Graphic .
' lemplate_c 2 v plakcat_data 7,386 73 10:56:47 Dlesaningg tables in Wz Graphic Hub

' lempisies 2 ' plakat_dsta 0 10:56:47 . Cleanireg table changelog

W' scrpt_unts 1} w" pre_suthen L] 10:56:47 Cleanirsg table wop_paramelers

" lags o " search_pro 0 10:56:47 . Cleaning lable mese_playksts_xml

" conteel_sce 0 ' E_maa_plmyl 0 10:56:47 .. Cleaning lably search_prviders

W' concepls 1 w W vEp_pame B v 10:56:47 Cleanineg lable pre_sutherticabed_hosis w
< » ] » [ »

<ok [ Met> ] [ aen b
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10. Click Next to open the Delete old Pilot elements window:

Dielete old Pllot elerments - |
Y ,
Blements cider than 1 year, E0d1] otal slements og| Moy elements
Barnants sldar than 1| manth 7386 lotsl slsments 423 Wrwy slemants
Bamants clder than 1 week Tagg lolal sements 433 | lorary slements

Cheanup oid Pilot datn elemants
Delete slemerts cldertan [